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Third Party Applications

Landmark acknowledges that certain third party code has been bundled with, or embedded in, Landmark’s 
software. The licensors of this third party code, and the terms and conditions of their respective licenses, 
may be found in the release notes of the appropriate point product.
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Introduction
Welcome to Release 5000.0.0.  Release 5000.0.0 is Landmark's first synchronous release of the 
DecisionSpace environment which accommodates your existing technologies whether that 
includes other vendor, proprietary, or Landmark solutions. Release 5000.0.0 delivers enhanced 
functionality and performance along with improved interoperability among applications for your 
E&P workflows. The DecisionSpace environment provides an open platform that allows you to 
adopt a "best-of-breed" strategy and leverage your current IT investments.

This release upgrades Landmark's product portfolio to support newer platforms, operating 
systems, processors, other vendors' software, video cards, and more.

New Workflows

In addition to the support for newer platforms this release includes significant data model changes 
and application interoperability driving visionary new workflows. Click on the page number's 
hyperlink to go to the workflow. 

• OpenWorks Software Project Optimization on page 17

• High-Performance Geoscience Interpretation Workflow on page 30

• Optimized Reservoir Decisions on page 37

• Prestack Seismic on the Desktop on page 46

Major Improvements to Release Components

• Interoperability of Applications. The Landmark suite of products share the same project 
databases (for example, OpenWorks and EDM) and have common platforms that offer 
seamless interoperability and optimal performance.

• Infrastructure. Landmark continues to innovate in the DecisionSpace environment which is 
built on the principles of service-oriented architecture resulting in common components and 
services. 

• Supported Platforms and Components. The release supports new platforms; operating 
systems; and third party applications (such as the Oracle Database and Macrovision FLEXnet 
Publisher). Providing such support helps you take advantage of the latest improvements in 
hardware and networking and offers better performance and larger processing capacities.

• Software Development Kits. New and updated Software Development Kits give you the 
flexibility to build your own workflows and solutions. The Engineer’s Data Model and 
DecisionSpace Infrastructure software development kits are being added to the existing 
portfolio of the OpenWorks Development Kit (which also includes seismic data management).
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The Release 5000.0.0 Program
Release 5000.0.0 will be delivered in several stages. The products that are scheduled to release 
in the first two stages are listed below. 

December 2007

The tables below show the products that are included in the initial release of Release 5000.0.0. in 
December 2007.

First Quarter 2008

The following applications are expected to release in the first quarter of 2008.

Drilling and Completions

CasingSeat (EDT application) PROFILE (EDT application)

Collaborative Well Planning Real-Time View (EDT application)

COMPASS (EDT application) StressCheck (EDT application)

Data Analyzer WELLPLAN (EDT application)

Information Management and Infrastructure

AssetJournal Team Workspace

EDM

Reservoir Management

DMS Nexus simulator

FieldPlan

Drilling and Completions

3D Drill View KM OpenWells

AFE Management System to EDT Link OpenWire

EDT Epoch Resource Scheduler Well Cost

iWellFile Wellbore Planner

Geological and Geophysical Technologies

DepthTeam Express PowerCalculator

GeoProbe PowerView

PetroWorks Prestack Data Server

PostStack SeisWorks
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Geological and Geophysical Technologies (continued)

StratWorks Well Seismic Fusion

SynTool Z-MAP Plus

TDQ

Information Management and Infrastructure

AssetView PowerExplorer

DecisionSpace Infrastructure PowerHub

OpenVision WOW/CDA/PA

OpenWorks

Reservoir Management

Nexus PowerGrid

Nexus Unified Desktop VIP
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Moving to Release 5000.0.0
Some applications require a specific version of the application before you upgrade to Release 
5000.0.0. Below is a list of products along with the version of the application you must be on prior 
to moving to Release 5000.0.0.

Product Version Comments

Drilling and Completions

3D Drill View KM 2003.19.1

AFE Management System to 
EDT Link

2003.16.1.2

CasingSeat 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

Collaborative Well Planning 2003.19.1

COMPASS 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

Data Analyzer 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

iWellFile 2003.21.1

OpenWells 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, 2003.16, or 
2003.21.

OpenWire 2003.0.8.1 or greater

Presgraf 2003.0.4

PROFILE 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

Real-Time View 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21
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Drilling and Completions (continued)

StressCheck 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

Wellbore Planner 2003.12

WELLCAT 2003.21.1  
or 2003.0.4.x

Well Cost 2003.16.1 or greater

WELLPLAN 2003.21 Scripts are available to 
upgrade from 2003.11, 
2003.14, or 2003.16 to 
2003.21

Geological and Geophysical Applications

PetroWorks 2003.12.1 Requires OW 5000.0.0

SeisWorks 2003.12.2 Requires OW 5000.0.0

StratWorks 2003.12.0 Requires OW 5000.0.0

SynTool 2003.12.0 Requires OW 5000.0.0 and 
SeisWorks 5000.0.0

TDQ 2003.12.1 Requires OW 5000.0.0 and 
SeisWorks 5000.0.0

Z-MAP Plus 2003.12.1 No requirements unless OW 
is installed, and then it must 
be OW 5000.0.0

Product Version Comments
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Information Management and Infrastructure

Corporate Data Store 2003.20.0.0 or newer Database will be upgraded, 
application is a new install.

OpenWorks 2003.12.0, or newer In OpenWorks 5000.0.0, the 
project upgrade process can 
upgrade individual projects as 
old as R98; however, if you 
want to upgrade projects with 
the batch upgrade process, 
the projects must be 
2003.12.0, or newer.

Projects can be migrated 
from an older version to 
Release 5000.0.0, but you 
must create a clean installa-
tion of OpenWorks 5000.0.0, 
and then migrate the old 
projects to the new installa-
tion one at a time.

PetroBank Master Data Store 2003.20.0.1 Database will be updated, 
application will be a new 
install

PowerExplorer 2003.20.0.0 or newer 
or 2003.20.1 or 
newer

Reference Data Manager N/A This is always a new install.

Team Workspace 2003.20.0.0 or newer

Production Optimization

TOW/cs TOW/cs 2003.14.0.2

Product Version Comments
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Discontinued Products
The following products will not be supported on the Release 5000.0.0 platforms. For more 
information, please contact your sales representative.

Drilling and Completions

DrillModel

Geological and Geophysical Technologies

PetroWorks ULTRA

GMI Imager

GeoProbe RSI

MVA/3DPSDM

DepthTeam Extreme

SeisZip

Information Management and Infrastructure

Geoshare Half Links

Engineer’s Link

OpenExplorer

Production Optimization

Desktop Navigator

OpenWire for Production
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Before You Install
After confirming that your application is at the correct version for upgrading to Release 5000.0.0, 
you should review the application release notes entirely. The new Landmark Software Manager 
gives you the ability to read both the Release Notes and Installation Guides prior to downloading 
the application. 

The Product Release Notes provide the necessary information about

• the specific platforms available for the application. (This information may be included in the 
Installation Guide.)

• enhancements and new functionality 

• known problems affecting the release

• the defects fixed for the release. 
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About Electronic Software Delivery and DVDs
For Release 5000.0.0, Landmark is introducing Electronic Software Delivery. You will be able to 
download your software as soon as it is available instead of waiting for disks to be shipped to you. 
Landmark is working with its customers to determine who will have the ability to use this new 
system. 

The customer interface for downloading products electronically is called Landmark Software 
Manager (LSM). It offers the opportunity to immediately download one or more applications or 
patches when it is convenient for you. LSM also gives you the opportunity to review the Release 
Notes and the Installation Guide prior to downloading the application or patch. You can then 
decide whether you want to download the release or patch. 

In addition, if you cannot download the applications through LSM due to bandwidth problems or if 
you prefer media, Landmark will provide DVDs to customers who request them. You can use the 
LSM application to request the DVDs. 



Landmark Release Notes

5000.0.0 Release Notes Page 13 of 84 December 2007

System Requirements

Supported Operating Systems

The chart below lists the Operating Systems for the Release 5000.0.0 supported platforms. All 
products will not be available on all systems. For example, most of the Drilling Applications are 
available only on Windows Operating Systems. In addition, some applications may run only on 
Linux and Solaris. Please refer to the Product Release notes or Installation Guide for the 
supported platforms for specific products.

• Microsoft Products:  
For DecisionSpace and Select Landmark Classic Technologies

Microsoft Windows XP 
and Microsoft Windows 2003 Server  
32 bit

IA32 X86_64 

Microsoft Windows XP 
and Microsoft Windows 2003 Server 
64 bit

X86_64

• Linux

Red Enterprise Linux 5.0 
64 bit

X86_64 (Note: The supported platform will be the x86_64 
architecture, but some applications will be built in a 32-bit for-
mat.)

• Solaris: 
For Landmark Classic Technologies Only

Sun Solaris 10 
64 bit

SPARC (Note: This supported platform will be the SPARC64 
architecture, but some applications will be built in a 32-bit for-
mat.)

• Application Hosting Environment

A note about Red Hat Linux support

The principal supported version of Red Hat Linux for the 5000.X Synchronous 
Release of Landmark’s product suite is Red Hat Enterprise Linux (RHEL) 5. This 
is the platform on which Landmark will be testing its Release 5000 suite of 
products. However, because of the timing of the RHEL 5 release (March 2007), 
Landmark developed its 5000.X applications and performed initial testing on RHEL 
4U4. Therefore, Landmark will provide support to customers who decide to deploy 
5000.X solutions on RHEL 4U4 or RHEL 5.
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Supported Components from Other Vendors

The charts below lists embedded and supported components that are used by many products. For 
a complete list of what is included in each product, please review the product’s Release Notes. 

Installing Landmark Application Manager (LAM)

The Landmark Application Manager is delivered as a separate application and is not included in 
the OpenWorks application. For instructions on how to install this application, please review the 
Landmark Application Manager Installation Guide. 

Embedded

Oracle Database 10g Enterprise 
Edition

MacroVision 
FLEXnet Publisher

Blue Marble Geographics 
Calculator 6.3

Sun Java 1.6

ESRI MapObjects v2.4

Prerequisites

Microsoft .NET 2.0

Crystal Reports 11.5

Hummingbird Exceed 2007

Microsoft SQLServer 2005

Mozilla Firefox 1.4 or newer

Graphics Cards

NVIDIA Quadro FX family of 
cards
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Third Party Applications License Agreements
Landmark uses various third party applications in its software. Information about third party 
applications is available for all products. The Release Notes will detail the third party information 
or define where the information is located. In addition, Landmark has included with most 
applications a file titled Third_Party.pdf which includes attribution and license information for all 
third party products used by Landmark. Third party information can be found at the following 
locations: 

• the Release Notes 

• at the location defined on page iii in the .pdf manuals 

• in the online Help
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Workflows

Four workflows have been created or enhanced for Release 5000.0.0. This section provides a 
description of each workflow and the products used in them. The index for the workflows is below. 

— OpenWorks Software Product Optimization (page 17)

— High-Performance Geoscience Interpretation (page 30)

— Optimized Reservoir Decisions (page 37)

— Prestack Seismic on the Desktop (page 46)
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OpenWorks Software Project 
Optimization

Applications Needed
• OpenWorks R2003 and Release 5000.0.0
• SeisWorks R2003
• Pre5000 Module (available from Landmark Customer Support)
• Text Editors (such as vi or Notepad)

Overview
Projects in OpenWorks and SeisWorks have been streamlined. 
Creating, restoring, and maintaining an OpenWorks project and 
the seismic data associated with the project have been simplified 
and enhanced. These changes were made to enhance the 
integration and data flow between all Landmark applications and 
to support the next generation of applications from Landmark.

These changes make it possible to:

• Reduce data duplication — An OpenWorks project (now 
called a project database) can be subsetted or viewed in an 
interpretation project, where the data in the interpretation 
project is shared dynamically by reference. Copies of data into 
multiple separate projects will not be required as they might 
have been in the past.

• Enhance data security — Access to the OpenWorks 
database is created only as an Oracle internal user. Access to 
project data, including seismic data, is controlled in each 
interpretation project. All seismic project data is now integrated 
into the OpenWorks project framework.

• Support multiple CRSs (Cartographic Reference Systems) 
— Each project database and each of its interpretation projects 
can have their own CRS. Cartographic conversion between the 
projects is automatic and dynamic.
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• Support processing history — Seismic and horizon data can 
have a processing history attached to it.

The sections below provide more details on the changes. Click on 
the blue hyperlinks to read the information.

• OpenWorks and SeisWorks Project Changes

• Data Changes

• Application Changes

• Interpretation Changes

• Accessing Data in Projects

OpenWorks and SeisWorks Project Changes

SeisWorks projects and their management applications have 
been removed in Release 5000.0.0. Seismic projects and their 
interpretation data have been integrated into the OpenWorks 
project framework. OpenWorks projects have been expanded to 
include the concept of projects and subsets or views of projects. In 
Release 5000.0.0, the parent project is a project database, and a 
subset of a project database is an interpretation project. A project 
database is similar in concept to a SeisWorks master project, and 
an interpretation project is similar to a SeisWorks working project. 
The integration of OpenWorks and SeisWorks projects removes 
the need for plist.dat, plist, or OW_PMPATH for project data in 
Release 5000.0.0.

A project in an OpenWorks database contains some of the 
seismic and horizon data in the database itself and refers to other 
seismic and horizon files not contained in the database. In 
Release 5000.0.0, 2D and 3D seismic data sets and 3D horizons 
remain in files as well as other data such as color maps and 
format definitions.

This new structure allows you to have less duplication of data 
between projects. Previously, whether because of the need of a 
narrow area of interest or because of data security reasons, you 
may have duplicated the same data in a number of projects. This 
situation made it difficult to add or correct data across a number of 
projects. In Release 5000.0.0, a project database can hold all the 
data for an entire region, and interpretation projects can be 
created which focus on only parts of the region. All data in the 
interpretation project, except for interpretation data itself, refers to 
data in the project database. When data is added or changed, it 
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only needs to be added or changed in the project database. All the 
interpretation projects based on the project database will see the 
new data or changes. Also, since the non-interpretation data is in 
only one project database, fewer system resources are required 
than may have been required in previous versions of OpenWorks. 

The subset of data in an interpretation project is determined by the 
coordinates of the interpretation project and by the well lists, 2D 
line lists, or 3D surveys you wish to include in the interpretation 
project. Each interpretation project can have a cartographic 
reference system (CRS) different from the project database or 
from other interpretation projects. Also, the manager of a project 
(project database or interpretation project) can determine who can 
access the project and the level of access each person will have 
in the project.

This new structure also relieves you from maintaining two sets of 
projects (OpenWorks and SeisWorks) and connecting the two. It 
also relieves you from the limitations of the old seismic project 
data model.

Data Changes

In Release 5000.0.0, OpenWorks and SeisWorks have changed 
where data and how data is stored in order to facilitate the 
integration of project data and to help facilitate the further 
integration of Landmark applications. For OpenWorks, the data 
model of the OpenWorks database has changed. For SeisWorks, 
the location of the seismic and horizon files as well as such files 
as color maps and format definitions can be fine-tuned for your 
needs.

OpenWorks Data Model

The data model of the OpenWorks database has been changed, 
adding new structures to store more data, and deleting unused 
older structures. The following changes were made in order to 
optimize and simplify data management in OpenWorks.

• 2D horizon data is stored in the OpenWorks database.

• Seismic and horizon data is cataloged in the database and can 
be given metadata.

• Seismic and horizon data can have processing history 
recorded (inputs, output, parameters, and process 
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information). Processing history can be viewed in Seismic Data 
Manager in either a textual format or a graphical format.

• Pre-stack seismic data is cataloged in the database and can be 
given metadata.

• Pre-stack processing history, as well as metadata and 
relationships between pre-stack data and its post-stack data, 
can be recorded.

• Version information can be recorded for interpretation data 
(such as fault or horizon attributes) and seismic data (such as 
seismic or pre-stack seismic attributes). The version 
information allows you to group data together.

• A structure horizon and its attribute horizon can be related.

• Multiple 2D line and multiple 3D survey interpretation are 
supported as a default.

• Horizon data can support multiple lines and multiple surveys.

• The WOW data model is integrated into the OpenWorks data 
model.

• The fault data model is improved and simplified.

• Interpretation notes and interpretation sets can be stored in the 
OpenWorks database.

• Remark fields are enlarged to 200 characters.

• Long remarks are added to allow you to create remarks or 
comments of practically any length.

Seismic and Horizon Files

The location of 2D and 3D seismic data sets and 3D horizon files 
is defined by the file dir.dat. As in R2003, dir.dat contains a list of 
file systems where seismic and horizon files can reside. However, 
instead of the old attributes (RO, SYS, and GLOBAL), the file has 
new attributes that let you determine where new files are created, 
allowing you to fine-tune the location and access of files. Files are 
created in a location based on the configuration of dir.dat and on 
the write permission of the user to file system.
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The attributes for a file system are the following:

• File suffixes (or extensions) — Indicates that a file of that type 
can be created on the file system.

• OTHER_FILES — Indicates that any file type can be created on 
the file system. At least one file system must have this attribute.

• fusion_seismic — Indicates that prestack seismic data can be 
created on the file system. If fusion_seismic is not specified, 
then prestack seismic will be written to the OTHER_FILES file 
system.

• fusion_horizon — Indicates that prestack horizon data can be 
created on the file system. If fusion_horizon is not specified, 
then prestack horizons will be written to the OTHER_FILES file 
system.

• No attributes — If no attributes are applied (no file suffixes, nor 
the OTHER_FILES attribute), no application can create new 
files on the file system; however, applications can still read and 
update files that already exist on the file system.

An attribute (a file suffix or the OTHER_FILES attribute) can be 
configured for more than one location at a time. When that is the 
case, a Landmark application will create a new file in a location 
based on which file system has the most free space and on the 
user’s write permissions for the file system.

When a Landmark application looks for an already created file, it 
will look in any file system listed in dir.dat, but it will only create 
files in a location allowed by dir.dat and by the read-and-write 
permissions of the user running the application.

Districts

Release 5000.0.0 formally supports the concept of districts. 
Depending on the company, districts might be called by various 
names, such as region, asset, or business unit. Districts are 
created:

• To subset OpenWorks projects and their seismic data.

• To allow a business unit or other group to focus on only the 
projects the business unit is working on.

• To provide additional security for the data in a project.



Landmark Release Notes

5000.0.0 Release Notes Page 22 of 84 December 2007

In previous releases, districts were implemented by configuring 
the OWSYSSID and OW_PMPATH environment variables and by 
configuring dir.dat, owdir.dat, and plist.dat for each district.

In Release 5000.0.0, as a default, at least one district must be 
created for each OpenWorks database. As in the past, dir.dat and 
owdir.dat are involved in the configuration of a district, but plist.dat 
is no longer needed for seismic data in Release 5000.0.0.

To create a new district or to modify an already created district, 
you edit a configuration file new to Release 5000.0.0, called 
district.dat (by default, it is located in OpenWorksHome/conf), and 
you create or edit the dir.dat and owdir.dat files for the district. A 
component of the entry in district.dat points to the location of the 
district’s dir.dat and owdir.dat. Other components of an entry for a 
district include the name of the district, comments about the 
district, and the name of the OpenWorks database the district is 
associated with. 

Districts function under the following principles:

• A district can be associated with only one OpenWorks 
database.

• An OpenWorks database can be associated with many 
districts.

• A project database can be associated with only one district.

• All interpretation projects for a project database belong to the 
same district as the project database.

• When a project database is created or restored, it is assigned 
to a district.

• OpenWorks Project Administration allows you to modify a 
project database and change its association with a district on 
the same OpenWorks database.

Application Changes

Landmark applications in Release 5000.0.0 access all data 
through an OpenWorks project, even SeisWorks applications. 
OpenWorks applications such as Well Data Manager and Seismic 
Data Managers have been rewritten to allow you to view and 
manage data in a project in ways the older applications did not 
allow.
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For example, Seismic Data Manager (SDM) has changed in the 
way it can view data and can access more data types than before. 
SDM allows you to sort, search, and filter data in a simple way and 
with complex boolean expressions. With the inclusion of seismic 
project data and seismic and horizon data into the OpenWorks 
framework, SDM has been enhanced to manage seismic data in a 
more efficient way. SDM also allows you to manage new data 
types, such as processing history and long remarks about seismic 
and horizon data. It allows you to export seismic and horizon data 
that was loaded into one project database and to import it into 
another.

Interpretation Changes

Interpretation in OpenWorks has changed. In previous releases, 
the name of an interpreter, unless it was public, could only be 
used by the user who created the name. In Release 5000.0.0, 
interpreter names have become interpretation IDs. An ID can be 
public or private. Anyone with access to the project can use a 
public ID. Such an ID is similar to an interpreter name with the 
public owner in R2003. If the creator of the ID chooses, an ID can 
be private, where the creator, or owner, is the only person who 
can use the ID, which is similar to interpreter names in R2003. 
However, if the creator of the private ID chooses, the private IDs 
can be configured to allow other users to also use the ID. In this 
way, a team of users can use the same ID if desired.

As in previous releases, the access to a project is based on 
whether a user has access to the OpenWorks database, not 
based on an interpretation ID. With the merging of SeisWorks and 
OpenWorks projects, the access to project data, including 
SeisWorks data, is ultimately controlled by the creator or restorer 
of the OpenWorks project database. The creator can then allow 
other users to have Manage access and other types of access to 
the project. These changes help centralize the control over all 
data in a project, including seismic data, not just what might have 
been classically termed OpenWorks data.

Accessing Data in Projects

A Landmark application, even SeisWorks applications, access the 
data in a project by selecting an OpenWorks project database or 
an interpretation project. Any application that accesses seismic 
data can access any project whether the project has only 2D lines 
or 3D surveys or both. Each project can have zero or more lines, 
or zero or more surveys.
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For example, typically, data from an entire region is loaded into an 
OpenWorks project database. Interpretation projects are created 
based more on the interpreter’s needs instead of the requirements 
of the database, its data model, or other considerations. When an 
application opens the project, it will access whatever data has 
been included in the project. Old limitations about the construction 
of seismic projects no longer exist. An application that can access 
an OpenWorks project can access whatever data is included in it.
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About the Workflows
The changes in the OpenWorks database facilitate integration and 
new workflows in most of Landmark’s interpretation 
applications.The changes to project data management can be 
exemplified in the creation and restoration of projects. Click on the 
blue hyperlinks to learn more.

• Create Project Workflow

• Restore and Upgrade Project Workflow

Create Project Workflow

This workflow details the creation of a project database in 
OpenWorks. For more information, see the OpenWorks Online 
Help. 

These workflows do not demonstrate all the functionality of the 
software.

The intent of this workflow is to demonstrate integration between the 
applications and does not include all of the software’s functionality. 
There are other possible ways the applications could be used 
together, as well as separately. Refer to the individual product’s 
online help for more information.

Edit district.dat

Programs Needed

• text editor

This step is only necessary if the new project should be in a district not 
already created. It is possible to assign the new project to an existing 
district, and then later to change the district of the project database 
using the Modify option in OpenWorks Project Administration.
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Edit owdir.dat

Programs Needed

• text editor

Typically, this step is unnecessary for an established district. If the district 
is new, owdir.dat should provide the location of the OW_PROJ_DIR 
directories for the district.

Edit dir.dat

Programs Needed

• text editor

This step is only necessary if you will be adding seismic and horizon data 
to the project. This file should list all the file systems where OpenWorks 
should look for seismic and horizon data for the project databases and their 
interpretation projects. Each file system can have attributes which help 
determine, along with a user’s write permissions on a files system, where 
Landmark applications can create new files.

Create project database

Programs Needed

• OpenWorks Project Administration

Create surveys or master grids for seismic data

Programs Needed

• Seismic Data Manager

Load data into the project database

Programs Needed

• ASCII Loader to load well data
• Curve Loader to load well log curves and other data
• Seismic Data Loader to load data into a 2D survey
• 2D Batch Control Monitor to extract line header and shotpoint 

information while loading trace data
• Poststack or 3D Batch Control Monitor to load trace data
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Restore and Upgrade Project Workflow 

To move data from R2003.12.x to Release 5000.0.0, you must 
first perform tasks in the R2003.12.x, and then perform tasks in 
Release 5000.0.0. This workflow refers to a single OpenWorks 
project and the SeisWorks data associated with it as an example.

In Release 2003.12.x

Edit and manage data

Programs Needed

• Curve Dictionary
• Seismic Data Manager
• Well Data Manager

Create interpretation projects from the project database

Programs Needed

• OpenWorks Project Administration

The data in an interpretation project can be based on one or any 
combination of the following: area of interest, a well list, a 2D seismic line 
list, or one or more 3D surveys. Conversely, you can select all wells that 
are not in a well list, all 2D seismic lines not in a line list, or all 3D surveys 
not in a selected list of surveys.

Manage and interpret data

The OpenWorks data and the seismic and horizon data are now ready for 
interpretation applications in Release 5000.0.0.

Install the Pre 5000.0.0 module

This module is available from Landmark Customer Support.

The module allows you to prepare seismic and horizon files and data (such 
as lists) for Release 5000.0.0. It provides information and tools to allow you 
to fix problems before they might arise when R2003 data is moved to the 
new project structure in Release 5000.0.0. For example, since SeisWorks 
projects might be combined, files with the same name must be renamed or 
otherwise dealt with.
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In Release 5000.0.0

Run the Pre 5000.0.0 module according to its documentation

The module guides you in doing the following:

• Create DistrictList.dat if the installation has more than one setting for 
the OWPM_PATH environment variable.

• Create a master staging project.
• Stage metadata.
• Run pre 5000.0.0 Report.
• Analyze the report to decide how to prepare the data.
• Make changes to the file names and data.

Back up OpenWorks project

Programs Needed

• OpenWorks Project Administration

Make SeisWorks project and data files available to Release 5000.0.0

This task may be merely making sure the file systems where the 
SeisWorks files are located are accessible to the Release 5000.0.0 
OpenWorks database and its users.

Or, the task may involve backing up the current SeisWorks directories and 
files, and then restoring files on another file system that is accessible to the 
Release 5000.0.0 OpenWorks database and its users.

Install OpenWorks 5000.0.0

Edit district.dat 

Programs Needed

• text editor

This step is only necessary if the restored project should be in a district not 
already created. It is possible to assign the new project to an existing 
district, and then later to change the district of the project database using 
the Modify option in OpenWorks Project Administration.
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Restore the OpenWorks project 

Programs Needed

• OpenWorks Project Administration.

Edit district and project files

Program Needed

• text editor

For the district associated with the restored project, edit:

• owdir.dat: Contains the paths to the OpenWorks project directories 
for the district.

• dir.dat: Contains the paths of the file systems where seismic and 
horizon files are stored and can be created. The file systems are 
locations of the SeisWorks project directories and data made 
available in a previous step. For the directories for this SeisWorks 
project, these file systems should have the attributes available in 
R2003 (SYS, RO, GLOBAL), not the new attributes in 
Release 5000.0.0.

• plist.dat: Contains the association between the OpenWorks project 
and the SeisWorks projects as they were in the previous release. The 
name of the OpenWorks project restored in a previous step must 
replace the OpenWorks project name used in R2003. In 
Release 5000.0.0, plist.dat is only needed during a restoration of an 
OpenWorks project that has one or more SeisWorks projects 
associated with it.

Upgrade project and migrate SeisWorks project data

Programs Needed

• OpenWorks Project Administration

Besides upgrading the project and migrating the data, the upgrade process 
allows you to create an interpretation project from each SeisWorks working 
project.

Manage and interpret data

The OpenWorks data and the SeisWorks project data are now ready for 
interpretation applications in Release 5000.0.0.
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High-Performance Geoscience 
Interpretation Workflow

Applications Needed
• GeoProbe
• PowerView with PowerCalculator
• Well Seismic Fusion
• OpenWorks 

Overview
The goal of the High-Performance Geoscience Interpretation 
Workflow is to provide a next-generation interpretation system 
that combines volume, seismic, and geological processes into a 
single seamless environment where quality prospects can be 
defined and rapidly explored. 

The workflow consists of these three elements:

• An easy-to-use 1D/2D/3D interpretation environment in which a 
small number of powerful applications performs the majority of 
interpretation workflows. These applications have a common 
user interface that provides access to data, application, and 
process integration.

• Automated basic processes that let interpreters spend most of 
their time working on high-level tasks.

• Data management that includes all interpretation elements. 
With all seismic, well, and interpretation data stored or 
referenced by the project datamodel, applications can read the 
data directly from the database.
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This example of the High-Performance GeoScience Interpretation 
Workflow uses GeoProbe, PowerView, PowerCalculator, and Well 
Seismic Fusion in the following manner:

1. GeoProbe, PowerView, PowerCalculator and Well Seismic 
Fusion: These applications are used in the first part of the 
workflow, Dynamic Integration, which focuses on interactive 
communication and updating of results among the applications.

2. GeoProbe: The second part of the workflow, Multi-Volume 
Interpretation and Frameworking, uses GeoProbe and modules 
within it to build a sealed structural model.

3. PowerView, GeoProbe, and Well Seismic Fusion: Basin 
Scale Interpretation, the third part of the workflow, combines 
the functionality of these three applications to build a simulation 
of basin evolution over time. The ultimate goal is to produce 
qualified play fairway maps.

4. Well Seismic Fusion: In Prestack Interpretation, the fourth 
part of the workflow, Well Seismic Fusion lets you interpret 
prestack seismic just as quickly and efficiently as you interpret 
poststack seismic.

This workflow does not demonstrate all the functionality of 
the software

This workflow demonstrates the integration between the 
applications and does not include all of the software’s 
functionality. There are other possible ways the applications 
could be used together, as well as separately. Refer to the 
individual product’s online help for more information.
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Data Flow

In this section, the four subworkflows of the High-Performance 
Geoscience Interpretation Workflow are displayed in separate 
boxes. Each subworkflow lists

• the programs that are being used

• the names of the documents containing the specific 
instructions for the steps in the subworkflows.
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Subworkflow 1 
Dynamic Integration

GeoProbe, PowerView/PowerCalculator, and Well Seismic Fusion contain the following 
functionality for dynamic communication and updating of results among the applications:

PowerView/PowerCalculator

• With the smartFault tool, track fault segments directly on semblance data.
• Use interactive cursor tracking to exchange positional information with GeoProbe.

For details, refer to the PowerView and PowerCalculator Online Help.

GeoProbe

• Display GeoProbe Probe outlines in PowerView Sections and Maps.
• Use universal tracking to see where Probes are.
• Compute attributes in memory on Probe faces to improve attribute-parameters testing 

and reduce data storage.
• With ‘data on demand,’ view and interpret unlimited volumes of data in 3D space.
• Click once to access prestack seismic interpretation in Well Seismic Fusion.
• Simultaneously analyze multi-attribute/multi-volume seismic, and well and cultural 

data.

For details, refer to the GeoProbe Online Help.

Well Seismic Fusion

• Drag and drop 3D seismic data, horizons, wells, and log curves between Well Seismic 
Fusion and the PowerView Inventory Tree or Select Session Data dialog box.

• PD wellbore and seismic x/y locations between Well Seismic Fusion and both 
PowerView and GeoProbe.

• PD an arbitrary 3D seismic line from the PowerView Section to Well Seismic Fusion.
• Extract wavelets from GeoProbe shared memory volumes.
• View and process GeoProbe .vol files and shared memory volumes in Well Seismic 

Fusion.
• See location markers in PowerView’s Map View for prestack gathers in Well Seismic 

Fusion.

For details, refer to the Well Seismic Fusion Online Help.

In any or all of these applications...

• Use interpretation notes to capture information about interpretation for future 
generations. The notes are stored in OpenWorks.

• Note a common look and feel.
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Subworkflow 2
Multi-Volume Interpretation and FrameWork Construction

The goal of this subworkflow is to apply 3D picking techniques to 2D and 3D data to build a 
sealed structural model.

GeoProbe

• As the interpretation progresses, use ezModel in GeoProbe to construct the 
framework model in these four steps:

— Load all interpretation data to the GeoProbe 3D interpretation environment. Use 
ezFault or swFault in GeoProbe to check faults. Clean and interpolate surfaces. 

— Load initial fault interpretation to the ezModel module to built a fault network. Seal 
the network based on fault relationships.

— Trim horizons and add polygons, if needed. The result is a sealed horizon and fault 
network with polygons.

— Validate and export. Color-code the fault polygons by the fault attributes of heave, 
throw, and slip. Test the horizon and fault interpretation for lateral slip along faults; 
erroneous fault correlations; or incoherent horizon interpretation. Save the model-
ready interpretation to SeisWorks, PowerView, and OpenWorks.

For details, see the GeoProbe Online Help.
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Subworkflow 3
Basin Scale Interpretation

This subworkflow involves building a simulation of basin evolution over time to produce quali-
fied play fairway maps.

PowerView

• In the Well Correlation view, set up log curve suite displays, save them, and recall 
them from OpenWorks. The result is rapid well log interpretation in detailed vertical 
track style displays that link to 2D and cross-section views.

• Access ESRI shape files and spatial database engines.
• Use interpretation sets to maintain a series of top prospect horizons or grids together 

with references to the velocity models used to generate them. Add more data as it 
becomes available so scenarios can be better evaluated.

For details, see the PowerView Online Help.

PowerView 2D Seismic Interpretation and GeoProbe 2D Seismic Visualization

• View and interpret unlimited volumes of 2D or 3D seismic in 2D or 3D space.

For details, see PowerView Online Help and GeoProbe Online Help.

PowerView and Well Seismic Fusion

• Select gather locations directly from PowerView Maps.
• Display prestack and stack seismic data in the same Sections to determine the 

validity of prospect attributes. 
• When an amplitude observation is validated, model it in detail in Well Seismic Fusion.

For details, see the Well Seismic Fusion Online Help.
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Subworkflow 4
Prestack Interpretation

When Well Seismic Fusion “publishes” prestack seismic data to the OpenWorks catalog, 
see the same prestack in place. In only hours, discover and use all the Prestack seismic 
data available to your company. With Release 5000.0.0 functionality, reduce risks in seis-
mic quality and the accuracy of reservoir prediction.

Well Seismic Fusion

• In Well Seismic Fusion, calibrate seismic data to reservoir attributes by creating, 
accessing, and storing offset synthetics and VSPs in OpenWorks Well Data Manager.

• Also in Well Seismic Fusion, see prestack seismic on the desktop and receive access 
to reservoir information previously unavailable to interpreters.

• Click on a stack volume in any Landmark application and display the prestack seismic 
data used to create that stack volume without any knowledge of where the prestack is 
stored.

• Interpret on the prestack seismic data and create maps of prestack attributes.
• Have the processor or specialist work on the same prestack as the interpreter to 

enhance the interpretation.

For details, see the Well Seismic Fusion Online Help.
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Optimized Reservoir Decisions 

Applications Needed
To run this workflow, you must have the following applications 
installed on a Windows XP computer.

• Nexus simulators
• FieldPlan Offshore
• DMS

Additional Requirements
In addition to the Release 5000.0.0 applications listed above, the 
user must have a complete set of Nexus project input data and the 
results from a Nexus job that has been run with this data.

The user must have the following applications installed:

• Microsoft® Access® or MySQL
• Microsoft ® Excel©
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Overview
The Optomized Reservoir Decisions Release 5000.0.0 workflow 
combines the following:

• physics-based reservoir simulation (Nexus simulators)
• expert-system based facilities screening (FieldPlan Offshore)
• uncertainty analysis (DMS)
• decision optimization (DMS)
• data analysis (DMS)

The workflow can be used to examine a range of strategies for 
designing the production facilities for an offshore oil or gas field 
and evaluating the trade-offs and economic benefits of available 
solutions. 

The workflow uses the Nexus simulators, FieldPlan Offshore, and 
DMS in the following manner.

1. Nexus Simulator: Used in batch mode to generate profiles of 
oil, gas, and water production in the reservoir over time. The 
project can include multiple reservoirs connected by a surface 
network plan. 

Important: This workflow assumes that you already have a 
Nexus project that defines the input parameters for the 
reservoir to be used in the workflow. The Nexus desktop 
utilities that you might use to create the Nexus reservoir inputs 
and surface network inputs are not included in the 5000.0.0 
initial release. However, you can create the Nexus project and 
surface network using the Nexus desktop tools available in the 
R2003.19.1 or R2003.19.3 release of Nexus.

2. FieldPlan Offshore: Used to model alternative production 
facility plans for developing a reservoir. The alternative 
strategies involve different engineering solutions that require 
different levels of capital investment and provide different 
production capabilities.

3. DMS: Used to assign “uncertainty variables” and “decision 
variables” to selected inputs in the Nexus model and to named 
ranges in a spreadsheet that is derived from FieldPlan. 

“Uncertainty variables” represent uncertainties that are beyond 
the control of the development team (for example, reservoir 
permeability). “Decision variables” represent options that can 
be varied by the team (for example, the number of wells or the 
platform type). 
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Once you have assigned uncertainties and decision variables, 
you run DMS jobs that sample the uncertainty and decision 
variables and generate production profiles that show the 
impact of uncertainties or facilities decisions on production 
results. Outputs can be written to a DMS database (MS Access 
or MySQL). 

4. DMS, Spotfire, or third party data analysis tools: DMS data 
analysis tools are used to analyze the results of the DMS 
uncertainty analysis and optimization jobs. Or, export the 
results to a filtered results database that can be loaded to 
Spotfire or other third party data analysis tools.

Note: You can modify this workflow to use a more complex 
economics spreadsheet while incorporating the costs data that 
is output from FieldPlan.

This workflow does not demonstrate all the functionality of 
the software

This workflow demonstrates the integration between the 
applications and does not include all of the software’s 
functionality. There are other possible ways the applications 
could be used together, as well as separately. Refer to the 
individual product’s online help for more information.
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Data Flow
The data moves from application to application as shown below.

Nexus

The Nexus simulators use Nexus data that has already been defined 
using a pre-Release 5000.0.0 version of the Nexus desktop. The data 
must be subsea data. It can include multiple reservoirs combined by a 
surface pipeline network. 

To expose a full range of reservoir properties for modeling with DMS, 
the Nexus model should include a structured grid. 

FieldPlan

You do not import the Nexus data directly into FieldPlan. Instead, you 
create a FieldPlan project that approximates the Nexus data. The 
FieldPlan project should mirror the Nexus project in areas where the 
FieldPlan and Nexus inputs are equivalent. 

For example, the FieldPlan project should have the same number of 
reservoirs, reservoir types, reservoir volumes, depth to top of reservoir, 
etc. 

Once you have created a FieldPlan project that parallels the Nexus 
project and run a FieldPlan job, you export recommended facilities 
solution to a DMS-compatible Excel spreadsheet.

DMS

DMS uses both the Nexus project data (.fcs, etc.) and the Excel 
spreadsheet that has been output from FieldPlan. DMS creates copies 
of the original data from both of these sources. 

DMS output data is written to an Access database (.mdb) or a MySQL 
database.
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Note: Optimization jobs typically require multiple iterations. 
Outputs from each run are factored into the selections made by 
the optimizer as it submits subsequent runs. In this sense, the 
data can be said to move in a “loop.”

DMS, SpotFire, or Other Third Party Data Analysis Tool

Output data from DMS can be accessed directly from its database 
using the DMS results browser. Alternatively, the user can export the 
data to a database that has been optimized for viewing with Spotfire.
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Workflow
To perform the Optomized Reservoir Decisions workflow, follow 
these steps:

Task 1: Analyze Nexus Project Data

1. Analyze the existing Nexus data that you will use. Your Nexus 
data should include both input data and output data (i.e., 
preliminary data describing reservoir conditions, production 
schedule, etc., and output spreadsheet data including well 
production results, field production results, etc.).

If you have the Nexus desktop installed, open the project’s .vds 
in SimDataStudio and look at the project’s input parameters 
there.

If you do not have SimDataStudio available, you can look at the 
Nexus .fcs file and the various ASCII files that it references. 
These will list most of the project input information.

For output information (cumulative production, etc.), look at the 
“ss” spreadsheets and the .out file that are produced after a job 
has been run.

2. Record the following in a text document or spreadsheet:

• type of reservoir
• number of reservoir(s)
• peak production rate
• number of production wells
• number of gas injection wells
• number of water injection wells
• size of reservoir
• projected production life cycle of reservoir
• number of wells
• well types (number of each type)
• well constraints 
• total recoverable reserves
• production rate (per well)
• field production rate
• reservoir areal extent (in acres)
• water depth
• reservoir ratio (length to width)
• water depth
• reservoir depth from mudline
• initial production rate per well

For information on the Nexus keywords that appear in the 
Nexus case files, see the Nexus Keyword Manual.
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Task 2: Create FieldPlan Project

1. Create a FieldPlan project that matches the features in the 
Nexus project data.

For example, the FieldPlan project should have the same 
number of reservoirs, reservoir types, reservoir volumes, etc. 

2. Run a single FieldPlan evaluation job to identify the best 
solution for building the offshore facilities for developing the 
reservoir.

3. Export the FieldPlan solution to a spreadsheet using the 
File > Prepare for DMS Analysis option.

For information on how to create a FieldPlan project, see the 
FieldPlan Offshore help system.
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Task 3: Create a DMS Project and Run Multiple DMS Iterations

1. Create a new DMS project.

2. Create a DMS/Nexus model that incorporates the Nexus .fcs 
file and its various include files.

3. Create a DMS/Excel model that incorporates a copy of the 
Excel spreadsheet that you generated with FieldPlan.

4. Assign uncertainty variables to the Nexus and Excel inputs that 
you want to vary when running Monte Carlo, sensitivity, or Latin 
Hypercube calculations. 
 
Some examples of uncertainty variables are reservoir 
properties such as porosity, permeability, etc., and financial 
uncertainties such as capital costs, rig availability, etc.

5. Assign decision variables to the Nexus or Excel inputs that you 
want the optimizer to vary as it attempts to optimize a specified 
objective function. 
 
Some examples of decision variables are number of wells, 
schedule start dates, etc.

6. Create a combined Nexus-spreadsheet model that uses the 
Nexus and FieldPlan models that you created in Steps 2 
and 3.

7. Create a DMS optimization job that uses the combined 
simulator-spreadsheet model.

If you are running an optimization job, specify an appropriate 
objective function for the optimization job.

8. Run the DMS job.

Typically, the job will perform reservoir simulation and 
FieldPlan economic calculations several times. 

For information on how to build DMS models and jobs, see the 
DMS help system.



Landmark Release Notes

5000.0.0 Release Notes Page 45 of 84 December 2007

Task 4: Perform Data Analysis

1. In DMS, use the results browser utility to view the outputs from 
the DMS job.

2. Alternatively, “flatten” the DMS results and import them into 
Spotfire or some other data analysis tool.

For information on how to perform data analysis in DMS, see 
the DMS help system.
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Prestack Seismic on the Desktop 

Applications Needed
• OpenWorks 5000.0.0
• PowerExplorer 5000.0.0
• PetroBank Master Data Store 5000.0.0
• SeisSpace 5000.0.0
• Well Seismic Fusion 5000.0.0

Overview
Prior to Release 5000.0.0, applications using prestack seismic 
data needed to maintain a private data store. In order to share 
data between applications, the prestack seismic data would 
typically need to be exported from one application and then 
imported into the other. This resulted in many copies of what is 
essentially the same data and a great deal of additional effort in 
converting and managing the separate data stores.

The goal of the Prestack Data to the Desktop workflow is to make 
all the prestack data within your organization available to the 
interpreter at the desktop and to allow each application in the 
prestack workflow to use a shared set of prestack data. The 
OpenWorks data model has been extended to include a catalog of 
information about the prestack data set, and, once the data is 
published to the OpenWorks catalog, it is available for use by 
each application. Prestack data can then be used by applications 
without the need for additional scanning, converting, or copying.

The workflow consists of five parts:

• Discover prestack gathers using PowerExplorer.
• Download prestack gathers to disk using PetroBank Master 

Data Store.
• Publish prestack gathers to OpenWorks using Well Seismic 

Fusion or SeisSpace. 
• Interpret and analyze prestack gathers using Well Seismic 

Fusion, PowerView, and GeoProbe.
• Enhance and/or reprocess prestack gathers using Well 

Seismic Fusion or SeisSpace.
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This workflow does not demonstrate all the functionality of the 
software.

This workflow demonstrates the integration between the 
applications and does not include all of the software’s functionality. 
There are other possible ways the applications could be used 
together, as well as separately. Refer to the individual product’s 
online help for more information.
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Workflow
When Release 5000.0.0 versions of PowerExplorer, PetroBank 
Master Data Store, SeisSpace, and Well Seismic Fusion are 
released, the following Prestack Seismic to the Desktop workflow 
functionality will be enabled.

Workflow 
Prestack Seismic to the Desktop

PowerExplorer, PetroBank Master Data Store, SeisSpace, Well 
Seismic Fusion and OpenWorks contain the following functionality to 
enable the Prestack Seismic on the Desktop workflow:

PowerExplorer

• Use PowerExplorer’s map view to display seismic surveys 
with available prestack gathers in your area of interest. 
Then select the prestack gathers you are interested in and 
generate a data request for PetroBank Master Data Store to 
retrieve the gathers.

PetroBank Master Data Store

• Retrieve requested gathers from the PetroBank Master 
Data Store data repository and download the gathers to a 
network-accessible disk.

SeisSpace and Well Seismic Fusion

• Publish the prestack gather references to the OpenWorks 
seismic data catalog using Well Seismic Fusion or 
SeisSpace. Once published the gathers are available for 
any one on the asset team to interpret and analyze.

Well Seismic Fusion, PowerView, and GeoProbe

• Interpret and analyze prestack gathers using Well Seismic 
Fusion, PowerView and GeoProbe. This includes AVO 
crossplotting and generating fluid and lithology attribute 
maps and volumes based on the prestack gathers.

Well Seismic Fusion and SeisSpace

• Enhance a subset of prestack data using Well Seismic 
Fusion or reprocess the entire volume using the high-
performance processing tools in SeisSpace. Changes to the 
prestack gathers are immediately available to all 
interpreters.
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Enhancements, New Functionality, and Fixed 
Problems
Release 5000.0.0 contains major changes and new functionality. The primary new functionality for 
the Classic applications is the incorporation of the new Seismic Data Management functionality in 
OpenWorks. It offers a high value to the management of seismic data in the end application. 

This section includes enhancements for many of the Release 5000.0.0 products that will be 
released throughout 2008. It also contains new functionality and fixed problems for the products. 

Because OpenWorks enhancements are among the most far-reaching, they are listed first. After 
OpenWorks, the products are grouped according to business lines and listed alphabetically within 
the groupings. More details of new functionality can be found in the New Features manuals or 
Release Notes for each point product.

For information on other products, click on these hyperlinks:

OpenWorks Release 5000.0.0 on page 49

Drilling and Completions on page 55

Geological and Geophysical Technologies on page 63

Information Management and Infrastructure on page 70

Reservoir Management on page 74

OpenWorks Release 5000.0.0

Seismic Data Management in OpenWorks

• Integration. Seismic data is more tightly integrated in the OpenWorks 5000.0.0 database. 
Some seismic data is catalogued and referenced in the OpenWorks database. Other seismic 
data is stored in the OpenWorks database.

— Catalogued: seismic data sets, 3D horizons, and prestack and poststack seismic data

— Stored: 2D horizons, misties, static shifts, horizon lists, and fault lists

• The Seismic Data Manager in OpenWorks 5000.0.0 allows you to:

— Manage the data it previously did: 2D and 3D surveys.

— Manage the seismic data listed above, which SeisWorks utilities managed in previous 
releases.
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• Seismic Project Manager Eliminated. With the change in project structure in OpenWorks, 
and because seismic data has been integrated into the OpenWorks database, the Seismic 
Project Manager no longer exists in Release 5000.0.0. Project Administration in OpenWorks 
now performs all project management.

• Project Data Transfer (PDT). To support the new data stored in the OpenWorks database, 
Project Data Transfer (PDT) has also been enhanced to support the transfer of 2D horizons, 
misties, and static shifts.

New Interpretation Project Optimizes Project Administration

Project administration has been simplified and optimized in OpenWorks 5000.0.0. A project can 
now be a view or subset of another project, and the master and working projects in SeisWorks 
have been integrated into the new OpenWorks project structure.

• Views of an OpenWorks Project

Projects have been renamed project databases. Each project database contains one or more 
interpretation projects. The interpretation projects are subsets or views of the data in the project 
database. Each interpretation project can have its own Cartographic Reference System (CRS) 
and lists of lines, surveys, and wells. With this new design, one copy of the data can have separate 
views, lessening the demands on computing resources and project and data administration. If 
data updates are needed, only the project database needs to be updated. Each interpretation 
project can be configured to automatically refresh the data in its view.

• SeisWorks Projects Replaced by OpenWorks Projects

OpenWorks projects are restored into the database, and the data from the SeisWorks projects are 
restored to the location where seismic data is to be stored in the environment. When the 
OpenWorks project is upgraded to Release 5000.0.0 in Project Administration, the SeisWorks 
project information is integrated into the OpenWorks project database. Each of the working 
projects from SeisWorks can become an interpretation project of the project database, depending 
on the configurations chosen by the person upgrading the restored OpenWorks project.

Projects and Districts

• The Ability to Separate Data. OpenWorks and its database now directly support districts. 
Districts allow a company to separate OpenWorks projects and seismic data into more 
manageable and secure groups. They become especially useful when a company may have 
large numbers of projects and when a company wants to separate data by business unit for 
better data security or storage ownership.

• Implementing Districts. In an installation of OpenWorks, a company can decide whether it 
will implement districts or not. To implement districts, dir.dat and owdir.dat must be configured 
for each district, and a new file, district.dat, must be configured with the name of each district 
and the directory of each district’s dir.dat and owdir.dat. Utilities, such as Project 
Administration and Project Status Tool, support districts in their interfaces. For example, when 
a user of OpenWorks creates a new project in Project Administration, part of the project 
configuration includes selecting the district to which it will belong.
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Data Model Enhancements and Removed Tables

The data model in Release 5000.0.0 contains enhancements and removes unused parts of the 
OpenWorks data model.

• Enhancements

— Storage for seismic data (2D horizons, misties, static shifts, horizon lists, and fault lists)

— References to seismic data stored in flat files (seismic data sets, 3D horizons, and 
prestack and poststack seismic data)

— Each Well Master table now has a Well Location table assigned to it. This table allows 
well data to be more easily transferred between an OpenWorks database and the Well/
Wellbore model of an EDM database.

— Storage for processing history

— Simplification of the fault plane trimesh model

— Storage for offset synthetics and vertical seismic profiles (VSPs) for Well Seismic Fusion

— Some validation (VC) tables have been converted to reference tables (R), and each refer-
ence table now has timestamp and source fields.

— Storage for interpretation notes

— Storage for interpretation sets

— Storage for 3D earth model frameworks

— Remarks attributes increased to 200 characters

— ID’s generated with sequences not OW_UID_VALUES

— Data Dictionary (support for Reference Data Manager)

— Storage of additional list tables (grid lists, fault lists, and horizon lists)

— Support for automatic position log computation when adding directional surveys

— Support for automatic handling of tie points

— Simplification of the data model for Depth Team Express

• Removed Tables

— PDEN production data model: The PDEN tables have been replaced with the PDM 
tables.

— ARIES Reserves Management

— VIP simulation grids

— Gocad model BLOBs

— OpenExplorer tables

— OpenWorks culture model: These tables were replaced by ZGF files in OpenWorks 
R2003.
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Development Kit Enhancements

The Development Kit for OpenWorks 5000.0.0 has been updated to:

• include functions to access the data in new tables of the OpenWorks data model.

• include functions to support data change messaging provided by Oracle’s Streams Advanced 
Queuing.

• remove functions related to tables that have been removed.

The Development Kit is built with Microsoft’s Visual Studio 8. For detailed information about 
changes in the Development Kit for OpenWorks, see the documentation included in the 
Development Kit. The Development Kit for OpenWorks is available separately from OpenWorks. 
Consult your Customer Support Representative for more information about acquiring the 
Development Kit.

Redesigned Data Management Utilities

OpenWorks 5000.0.0 includes several redesigned project management utilities and data 
managers.

• Project Utilities: Project Administration and Project Status Tool

• Data Managers: Data Domain Manager (now allows editing of the data dictionary as well as 
reference data), Curve Dictionary, Map Data Manager, Seismic Data Manager, and Well Data 
Manager

These new utilities and managers have the following benefits:

— Cross-platform Java applications, which do not require X Window System or Motif sup-
port in any operating system.

— Enhanced integration with more Landmark applications, because they are based on com-
ponents from Landmark’s DecisionSpace products.

— Powerful table functions that allow users to search, sort, view, and manipulate the data 
displaying in a project utility or data manager.

Private Interpretation IDs

Interpretation ID Manager replaces the Interpreters utility. The manager allows you to create 
interpretation IDs that are comparable to the names you would have created in the Interpreters 
utility, plus more. 

• New Tables for Searching, Editing, And More. The interpretation IDs, along with their 
associated data, are presented in a table that allow you to sort, filter, and search the table; 
change the appearance of the table to make some data more prominent; and export rows of 
data to a file.
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• Editing IDs. You can edit an ID in the table or in a form view.

• More Room for Remarks. The Description field in the Interpreters utility has become a Long 
Remark field that allows remarks of indefinite length.

Interpretation IDs can be public or private. Public IDs are similar to the names created in the 
Interpreters utility and are accessible by any user of the OpenWorks database. Private IDs allow 
you to create an ID limited to only certain users. Each user added to a private ID has one of three 
security levels: owner, manager, or interpreter. An asset team can manage one or more private 
IDs to fit the purposes of the team.

Support for Oracle Streams Advanced Queuing (AQ) for Data Change Messaging

OpenWorks now uses Pointing Dispatcher (PD) just for communications between its client 
applications. Oracle’s Streams Advanced Queuing (AQ) now conducts data change messaging 
with the OpenWorks database.

Advanced Queuing has several advantages:

• Communication. Changes to the data in an OpenWorks project are reliably communicated to 
any application accessing the project across a network.

• Monitoring Updates. AQ allows Landmark applications accessing the OpenWorks database 
to more easily and efficiently monitor data updates from multiple workstations on a network in 
real-time.

• Configuration. Previously, PD sometimes required special configurations and environment 
variables for some applications to be able to receive notifications about data changes. With 
AQ, those configurations are unnecessary. If the application can communicate with the 
OpenWorks database, the application can receive data change notifications.

• Faster Communication. AQ messages can indicate the boundaries of a transaction with the 
database. The applications accessing the OpenWorks database can then commit a set of 
change messages at the end of the transaction instead of at each individual change. This 
capability speeds up communication with the database.

OpenWorks Users are Now Internally Authenticated Users

OpenWorks now uses the Oracle Secure Enterprise Password Store (Oracle Wallet) to store 
passwords to the database and to handle the security of the passwords.

When a new user is added to the OpenWorks database, the user is associated with the user’s 
name in the operating system. When the OpenWorks user first starts an OpenWorks application, 
the user must provide a password to the OpenWorks database. The user name in the operating 
system and the database must be the same, but the passwords can be different.

When a user accesses an OpenWorks database with a web-based application, the application 
prompts the user for a user name and password. Then, access to the data is allowed.
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Data Model Rationalization Between OpenWorks and Engineering Data Model 
(EDM)

OpenWorks now includes a table for well locations. Each wellbore (Well Master table) is 
associated with a Well Location table that relates to the well/wellbore data model in EDM. The new 
well data model in OpenWorks allows well data to be more easily transferred between Open 
Works and EDM.

Other Changes

• Processing History. OpenWorks now captures the data types of the input and output data 
and captures the parameters that transform the data from input data to output data. 
Specifically, the processing history retains interpretation knowledge and the context of the 
data. It allows you to revise interpretations with new data, and makes cleaning and archiving 
projects easier. It allows one team to easily hand off a project to another team, and can 
minimize productivity loss when the composition of an asset team changes.

• Application Preferences. In the rewritten utilities and managers, a user can save 
preferences. Besides user preferences, each application has default preferences, and some 
preferences can be set for the entire OpenWorks site.

• New Error Logging Console. In the rewritten utilities and managers, a Tools menu allows 
you to display the Error Logging Console. The Error Logging Console allows you to view errors 
as they occur without resorting to a terminal window, and to dynamically set the error reporting 
level for the console window and the error log file separately.

• Updated Geographic Component. Release 5000.0.0 includes components from GeoCalc 
6.3 (from Blue Marble Geographics) for coordinate transformations.
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Drilling and Completions

Engineer’s Desktop (Entire Suite of Products)

• Platforms and Databases. The Engineer’s Desktop suite of applications is now available on 
Windows Vista Enterprise for the 5000.0.0 release. Supported databases for 5000.0.0 are 
Oracle 10g, Microsoft SQL Server 2005, and Microsoft SQL Server 2005 Express.

AFE Management System to EDT Link

• Platform. AFE Management System to AFE Link is an application on Engineer’s Desktop 
5000.0.0. For this release, AFE Management System to AFE Link is available on Windows 
Vista Enterprise.

CasingSeat

• Platform. CasingSeat is an application on Engineer’s Desktop 5000.0.0. For this release, 
CasingSeat is available on Windows Vista Enterprise.

• New Default Tabs. Tabs are saved at the Design level. In the past, tab layout was saved by 
individual users. Now when a Design is saved, the tab layout and content are saved as the 
default view setting for the Design. The new tab settings become the view for all other users 
who open the Design.

• Internationalization. CasingSeat is now designed to support regional settings in Windows.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• OpenWire 2003.0.8. It can be launched directly from the Well Explorer with a right-click menu 
command at the Database level.

• Formations Added to the Associated Data Viewer. They allow formations to be copied 
between Designs.

• New Assemblies Added to the Associated Data Viewer. They have copy/paste 
functionality: Casing. Not valid for Actual Designs.

• Catalogs Added for Well Completion Components. Support for these catalogs was added 
to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

COMPASS

• Platform. COMPASS is an application on Engineer’s Desktop 5000.0.0. For this release, 
COMPASS is available on Windows Vista Enterprise.

• Targets. They can now be assigned to additional hierarchical data levels, including Project, 
Site, Well, Wellbore, and Design.
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• Printing. It is now possible to print, or use print preview, from the Survey and Plan Editors.

• Column Order on the Survey and Plan Editors. It can now be changed.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Integrated WITSML v. 1.2 Support. It allows the creation of OpenWire 2003.0.8 pipelines 
from the Well Explorer tree to load data into the EDM database directly from a remote WITSML 
server.

• OpenWire 2003.0.8. It can be launched directly from the Well Explorer with a right-click menu 
command at the Database level.

Data Analyzer

• Platform. Data Analyzer is an application on Engineer’s Desktop 5000.0.0. For this release, 
Data Analyzer is available on Windows Vista Enterprise.

• Metadata Update. The Selection Tree metadata used for both Data Analyzer and the Data 
Validation feature within OpenWells (including EDM Administration Rule Book Editor) has 
been updated to reflect data model changes and additions that are new for this release. This 
includes being able to query data in the new Completions Catalogues, Multi-Wellbore Well 
Planning, and Oilfield Waste Management extensions to OpenWells.

• Fixed Defects. The following significant defects for Data Analyzer were corrected:

— Defect #728645: Catalog Editor tree should be in sort order.

— Defect #730022: Fluids (CD_Fluid) View should not be linked in when reporting on Stimu-
lation Views.

— Defect #735916: Graph Wizard Step 3 Dialog Name is incorrect.

OpenWells 

• Platforms. OpenWells is an application on Engineer’s Desktop 5000.0.0. For this release, 
OpenWells is available on Windows Vista Enterprise.

• Planning of Multilateral Wells. The Well Planning input form was enhanced to enable 
planning of multilateral wells, so that multiple wellbores and designs are now supported.

• Completions Catalogs. Enhancements were added.
• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 

to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Catalogs Added for Well Completion Components. Support for these catalogs was added 
to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.



Landmark Release Notes

5000.0.0 Release Notes Page 57 of 84 December 2007

PROFILE

• Platform. PROFILE is an application on Engineer’s Desktop 5000.0.0. For this release, 
PROFILE is available on Windows Vista Enterprise.

• Extended Planning and Reporting. The primary focus for this release of PROFILE has 
been to extend planning and reporting for Completions and Multi-Laterals (OpenWells) 
through new Completions equipment catalog selection architecture and associated comple-
tions-related enhancements. The goal is to enable completions and well services teams to 
better document and manage completions from planning to installation and management 
through to abandonment. In addition to the catalog selection architecture, assembly and com-
ponent description interfaces are extended so that additional information and supporting doc-
umentation can be saved with the data. In addition, PROFILE is now extended to support 
description and visualization of equipment attached to Casing and Completion assemblies.

• Completion Catalogs Selection. This feature is now enabled in the Well Designer Wellbore 
Equipment and Wellheads tabs. In the Wellheads tab, Completion Catalogs are grouped by 
wellhead components and hangers in accordance with Catalog Editor organization.

• New Equipment Section Types. To support better segregation of different types of comple-
tion tools, a number of new equipment section types with supporting component type lists 
have been added to the Landmark standard list of equipment for this release.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Catalogs. They were added for Well Completion components. Support for the catalogs was 
added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

Real-Time View

• Platform. Real-Time View is an application on Engineer’s Desktop 5000.0.0. For this release, 
Real-Time View is available on Windows Vista Enterprise.

• Key New Features. This release of Real-Time View sees the introduction of a number of key 
new features that enable operators to manage more effectively both time-based and depth-
based log data within their Engineer’s Desktop environment. These improvements include:

— Depth-based log storage and visualization. Real-Time View has been extended to 
also support depth-based logs. A new LAS import feature is available for Depth-based 
logs so that log files available in that format can be imported, stored in EDM, and visual-
ized within Real-Time View.

— Log and Curve Header Editor. For active logs, a new Log Header Editor feature is avail-
able from the Tools menu (Tools > Edit Log Header…). This feature enables engineers 
to review and edit Log and Curve Header information inaccessible in previous versions of 
Real-Time View.

— Internationalization. Real-Time View has been extended to enable the user interface 
text to be translated into other languages.
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— WELLPLAN Integration. You can now use Real-Time View Template Viewer to display 
Depth-based drilling data logs within WELLPLAN. This feature allows real-time data 
imported into EDM via OpenWire to be displayed inside WELLPLAN for a particular 
Design/Case. The capability provides the engineer with a valuable reference when com-
paring predicted actual loads against those actually measured during well construction.

— Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders let you 
organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy 
that can be up to three levels deep.

StressCheck

• Platform. StressCheck is an application on Engineer’s Desktop 5000.0.0. For this release, 
StressCheck is available on Windows Vista Enterprise.

• Tab Layout. Default tabs were added. (Tabs are saved at the Design level.) In the past, tab 
layout was saved by individual users. Now, when a Design is saved, the tab layout and con-
tent are saved as the default view setting for the Design. The new tab settings become the 
view for all other users who open the Design.

• Viewing of Classic Well Schematic. You now have the option to view the Classic Well 
Schematic. When StressCheck is installed, the default schematic view displays. To change to 
the Classic view, select Tools > Options and activate the Classic Schematic View checkbox. 
Deactivation of this checkbox will return the schematic display to the default setting.

• Internationalization. StressCheck is now designed to support regional settings in Windows.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• New Assemblies. There were added to the Associated Data Viewer with copy/paste 
functionality: Casing, Tubing. Not valid for Actual Designs.

• Catalogs. These were added for Well Completion components. Support for these catalogs 
was added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

WELLPLAN

• Platform. WELLPLAN is an application on Engineer’s Desktop 5000.0.0. For this release, 
WELLPLAN is available on Windows Vista Enterprise.

• New Friction Calibration Torque Drag Chart. This new feature allows for graphical calibra-
tion of friction factors.

• New Plot. The pressure to break the gel strength at various times can be determined using 
the Pressure-ECD Chart (Pressure: Pump Rate Fixed).

• Back Pressure Available in Analysis. You can use the Pressure: Pump Rate Fixed Analy-
sis Mode and the Pressure: Pump Rate Range Analysis Mode.
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• Reverse Circulation. This procedure, which pumps cement and spacers directly down the 
annulus, can now be modeled.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders let you 
organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Integrated WITSML v. 1.2 Support. This feature allows creation of OpenWire 2003.0.8 
pipelines from the Well Explorer tree to load data into the EDM database directly from a remote 
WITSML server.

• OpenWire Pipelines. These can be created directly from the Well Explorer. You can launch 
the Real-Time View application directly from the Associated Data Viewer and use it to 
compare actual and planned log data.

• Catalogs. These were added for Well Completion components. Support for the catalogs was 
added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

• New Assemblies. These were added to the Associated Data Viewer with copy/paste 
functionality: Casing, Tubing, and Drillstrings. Not valid for Actual Designs.

• Fixed WELLPLAN Problems. The following significant defects were fixed:

— Defect #743765: Java Exception warning when creating a WELLPLAN case from a 
StressCheck casing design.

— Defect #748119: Backreaming results not updating when changing friction factors when 
all loads were selected on the Mode Data dialog.

— Defect #750148: Cannot change the mud density units to specific gravity for an API- 
based custom unit set, or to ppg from an SI-based unit set.

— Defect #752276: The cuttings loading option does not affect the Hydraulics drag chart 
analysis results.

— Defect #752297: When using the Hydraulics Pump Rate Fixed analysis, the tool joint 
option does not affect the results displayed in the Hydraulics drag chart or the Annulus 
ECD plot.

3D Drill View KM

• Platforms. 3D Drill View KM is a DecisionSpace application. For Release 5000.0.0, 3D Drill 
View KM will be available on the official Release 5000.0.0 Linux and Windows XP platforms, 
and will access OpenWorks 5000.0.0 on Oracle 10g. 

• Create Knowledge Attachments in 3D View. To create a Knowledge Attachment in the 3D 
View, right-click on a wellbore and select Add EDM Knowledge Attachment, or Add DIMS 
Knowledge Attachment depending on the drilling database you are using. Note that you must 
have checked the Enable box on the corresponding KM EDM or KM DIMS tab. 

• Knowledge Attachment Symbols Stored in EDM Database. KM symbols are now stored in 
the EDM database. (Prior to R2003.19.1, the symbols were stored in files.) Any symbols 
stored in files will be uploaded into the EDM database the first time you open the database. 
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• 3DDV KM Runs on Linux. 3DDV KM now runs on Linux and can connect to either Oracle or 
SQL Server EDM databases. 

• Select All and Clear All Buttons. The buttons were added to the Choose Items dialog box 
to improve its usability. 

Collaborative Well Planning

• Software Family in the DecisionSpace Environment. It now includes AssetPlanner, 
TracPlanner, PrecisionTarget, and the new Field Scenario Planner applications.

• Platforms. For Release 5000.0.0, the Collaborative Well Planning applications will be avail-
able on the official Release 5000.0.0 Linux, Solaris, and Windows XP platforms and will 
access OpenWorks 5000.0.0 on Oracle 10g.

• Manual Targeting. Several enhancements were included to allow better use of geologic 
models and to provide more control when creating targets for both manual and automatic 
planning. 

• References to OpenWorks Saved in OpenWorks WellPlanning Projects. 
WellPlanning objects created from OpenWorks wells are saved with the OpenWorks Well-
Planning project. Therefore, OpenWorks will automatically load these wells when the Open-
Works well is opened. 

• Recommended Surface Location or Kickoff Depth Based on Hold Angle. The software 
can recommend a surface location or kickoff depth based on a specified hold angle. The sur-
face location or kickoff depth will be calculated using a hold angle as close as possible to the 
requested hold angle. 

• Sidetrack Plan Type Added to the AssetPlanner Advanced Mode. AssetPlanner can now 
create sidetracks from existing or planned wells. Sidetracks can be based on three plan 
types, including sidetrack, horizontal sidetrack, and S-shaped sidetrack. It is possible to 
restrict the creation of sidetracks to a certain well type such as shut-in, etc.

• Snap Penetration Points in Reference Targets. When working with TracPlanner, use 
Plans > Snap Reference Targets to move the reference target penetration point to the point 
where the wellbore intersects the target. (The default penetration point for the reference tar-
get is the center of the target.) 

• Casing and Liner Data. A Casing tab has been added to the Well Plan Properties dialog 
box. Casing and liner data available in OpenWorks is displayed (read-only) on this tab. When 
creating a new plan, data can be entered into this tab. This data is used when creating side-
tracks to ensure the minimum inside diameter criteria is met. 

• Improved Sidetrack Options. Existing sidetracks now have the same planning options as 
new sidetracks. This functionality includes investigating alternative millout depths within a 
specified distance from the current millout depth. You can specify a minimum inside diameter 
to determine if a sidetrack is possible at any depth by comparing this diameter to the casing 
and liner data. 

• New Setting. Set Back TVD - Use Plans > Apply SetBack to ensure the wellpath has the 
same inclination and azimuth from the last target to the specified (Set Back) TVD above the 
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second to last target as it does between these two targets. This functionality applies to sur-
face or platform plans using Optimum Align and consisting of at least two targets. 

• Plan Optimization Enhancement - Optimization. It now includes penetration points, kickoff 
depths, and millout points, as well as automatically testing for more efficient plans using refer-
ence targets. Anticollision and hazard avoidance will be considered if the AssetPlanner mod-
ule is licensed. 

• Table Editing. Several changes were made to improve table editing. Buttons were renamed 
for consistency, and cell contents are automatically overwritten when typing begins in the cell. 

• Editing of Well Types. It is now possible to change the type of a well (producer, injector, 
etc.). If the well is an OpenWorks well, the change is only within the context of the current 
Well Planning project and does not change the actual OpenWorks type. 

• Saving and Retrieving Plan Parameters. In AssetPlanner and ScenarioPlanner, plan set-
ups can now be saved and retrieved for later use. 

• Improved Completion Calculation. A parameter titled “Default Reservoir Penetration” has 
been added to the Costs tab in AssetPlanner. This field is used to determine where to begin 
completion costs. In the past, completion costs were based on the perforation length. For 
wells without a perforation length, a zero length completion interval resulted. 

• Editing Target, Plan, and Scenario Parameters. Any numeric column can now be edited 
and saved to the project. Columns can also be added or deleted. Note that this save applies 
only to the WellPlanning project and does not affect OpenWorks data or wbp files. 

• Importing Paths as TurnPoints. Turn points can now be derived from imported survey data.

• New Plan Type Parameters. Additional parameters were added to several plan types. 

• Field Scenario Planner. A new module titled Field Scenario Planner has been added. This 
module includes three modes: Scenario Setup, View Scenario Set, and Scenario Target Anal-
ysis. 

— The Scenario Setup mode facilitates the creation and editing of a set of development 
scenarios.

— The View Scenario Set mode is used to compare the scenarios created using the Sce-
nario Setup mode.

— The Scenario Target Analysis mode is used to compare scenarios on a target-by-target 
basis.

• Scenes. A new Scenes tab takes advantage of AssetView’s multi-scene, multi-view function-
ality. 

• EDM Import and EDM Export - EDM Import and EDM Export Options. These have been 
added to the File menu. Use these options to import or export data between Well Planning 
and an Oracle EDM database (version 2003.16.0 or later). 

• Surface Grids. You can now use surface grids when you are working with AssetPlanner. For 
example, a sea floor grid can be used to obtain water depth. Using the water depth from the 
grid, AssetPlanner can put platforms in a specified water depth. You could also use a topog-
raphy grid to place platforms or wells only where the surface is less than a certain inclination.
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• Site Slot Templates Setups. These can now be saved. The site setup that is saved can 
include multiple templates and/or individual wells. After the setup is saved, it can be used as 
a basis for other sites. 

OpenWire

• Platforms. For Release 5000.0.0, OpenWire is available on Windows Vista Enterprise Client 
(Vista Server is not supported), Windows XP Client, and Windows 2003 Server.

• Supported Versions. OpenWire will support WITSML version 1.3.1 as well as version 1.2.0 
for the standard objects.

• Integrated Workflow. OpenWire supports an integrated workflow with the EDM-based appli-
cations, allowing simplified creation of Pipelines from within the Engineering applications.

• Support for Reports Objects. OpenWire now supports the reports objects for simplifying the 
data entry into OpenWells when data is available in a digital format.

Wellbore Planner

• Platforms. Wellbore Planner is now available on the official Release 5000.0.0 Linux and 
Solaris platforms and will access OpenWorks 5000.0.0 on Oracle 10g.

• Wellbore Planner Fixed Problems:

— Defect #163061: Wellbore Planner does not populate the Original location information for 
a well when created from a well plan. 

— Defect #722088: Recalculation of wellpath (position log) causes duplicate line in poslog 
table. As a result, the wellpath will not display in OpenVision, and an error message will 
display indicating the wellpath cannot be loaded. 

— Defect #177358: When a WBP plan is saved as an OpenWorks well, the time/depth table 
created is not set to be the preferred time/depth table. 

— Defect #702580: Import of ASCII file containing survey data (knee points) is limited to 197 
data points.

— Defect #719633: Wellbore Planner freezes when importing a COMPASS ASCII file with 
more than 196 lines.

— Defect #306010: COMPASS file fails to import if comment line exceeds 78 characters.

— Defect #732053: Wellbore planner not saving platform wells correctly.

— Defect #732054: Wellbore planner not saving turn point correctly for extend sections.

— Defect #156683: Parent well not retained after saving plan and reopening second time.

— Defect #118667: Entering large character strings into the Uncertainty > Survey Tools > 
Edit Name and Description fields produces an error when the Add/Update icon is 
selected. 
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Geological and Geophysical Technologies

These applications use the new Seismic Data Management functionality in OpenWorks. For more 
information, see Seismic Data Management in OpenWorks on page 49. 

GeoProbe + ezModel

• OpenWorks 5000.0.0. Port. For Release 5000.0.0, the OpenWorks data model has been 
streamlined to reduce data duplication. Now, you can view subsets—called interpretation 
projects—of a project database; the data in the interpretation project is shared dynamically by 
reference. In addition, seismic and horizon data can have a processing history attached to 
them. GeoProbe's data structure has been modified to accommodate these changes.

• Multi-Survey States. GeoProbe's data structure has been re-configured to take into account 
individual surveys located within a larger project. Now, Multi-Survey instances in GeoProbe 
can be saved into a single state file.

• Data on Demand. In addition to loading volumes into shared memory, you can now load 
volumes directly from disk into GeoProbe using Data on Demand. When you use this new 
*.d3d disk caching format, loaded volumes are no longer limited to the amount of memory on 
a given system. Therefore, you can load large data volumes without compromising 
visualization speed.

• Seismic 2D Data Direct from SeisWorks. Seismic 2D Data can now be loaded into 
GeoProbe directly from SeisWorks. swFault segments are easily interpreted on these 2D lines 
and saved back to OpenWorks. In addition, horizons are picked using ManuTrack and can be 
interpolated on demand using the SeisWorks gridding library. To further improve the 
interpretation workflow with PowerView, 2D line locations are now shared via PD messaging.

• Direct Data Access. Data loading has been reconfigured to remove the requirement for an 
external DataServer. This change has greatly optimized the loading of swFaults, Horizons, 
and 2D Data; they are now loading 10 to 20 times faster than in previous versions. 

• Culture Object. A new Culture object lets you load and manipulate ZGF layers. These culture 
files can be clipped to volume extents, and individual layers in single files can be enabled and 
disabled from view.

• Blending Volumes into a Single Display. Advances in graphics card development give 
GeoProbe the ability to “blend” two volumes into a single display. For example, by using a 
seismic amplitude volume as a base volume, you can now overlay a velocity volume on the 
seismic. The second volume still has a color map of its own, and transparency values on this 
color map determine the saturation of the volume on the display. In addition, when you use the 
new dynamic waveform display, wiggle traces can be displayed on the faces of a Probe. 
Parameters that determine the size, spacing, and overall appearance of these traces can be 
set.

• Horizon Curvature. A variety of Horizon Curvature attributes are now available for display on 
the selected horizon. These attributes aid in the prediction of fractures and faults. 
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• ezTracker Fault Blocking Option. ezTracker can now use a “fault blocking” volume created 
from within PowerView. Using this volume in conjunction with the tracking algorithm will quickly 
create horizons that are constrained by the faults in the survey. You will not have to interpret 
the fault network first.

• ezModel Additions. More options have been added for working with horizons in the structural 
model. Horizons can now be sealed against one another; based on the order they occur in 
time/depth. In addition, specifying each horizon interval's minimum thickness allows for a 
wider variety of stratigraphic models.

• Well Section. This new feature creates a vertical plane of seismic data through the path of the 
selected wellbore. These planes display the data around the wellbore as well as any enabled 
horizon and fault interpretations that intersect the plane. 

• Usability Improvements. All objects in the GeoProbe viewer are now selectable and can be 
disabled using Mouse Button 2. The object's full menu can be accessed using MB3. Tabs for 
swFaults and ezFaults have been added to the User Preferences dialog box. They let you 
configure display and interpretation settings that will persist in the GeoProbe session.

PetroWorks

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data, 
major enhancements to the Interpretation ID Model, the addition of metadata and Processing 
History Model, redesigned Data Managers, and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• Log Modeling Package. The PetroWorks Log Modeling Package now includes log 
normalization and the ability to create pseudo logs.

PowerCalculator

• New Data Types. They include the following:

— Support for 2D horizons for a variety of math computations.

— Support for OpenWorks grids for complex math computations. In general, the grids can 
be used interchangeably with 3D horizons, making for some very powerful, yet simple, 
workflows.

— OpenWorks polygons, which can be used in some new functions that support processing 
of the grid information.

• New Calculations and Modes. They include the following:

— Calculations can be executed in “Multiple” mode, which enables operations between 3D 
horizons in different seismic projects.
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— The QuickView now supports the display of multiple data simultaneously. This enhance-
ment lets you quickly evaluate if and how disparate data types overlap within regions.

— A robust spatial interpolation algorithm is added for 3D horizon data. By being a part of 
the PowerCalculator processing flow engine, this algorithm enables a single button click 
to fill, smooth, and clip within the interpreter’s favorite set of algorithms.

— The Blank function applies a specific polygon set, containing inclusive and/or exclusive 
polygons, to a 2D or 3D horizon, or to an OpenWorks grid.

PowerView

• Interpretation Notes. This enhancement provides advanced tools for interpreters to add x, y, 
z location markers containing text, images, and links to documents. Interpretation notes can 
also be attached to other data objects. This information is captured as a permanent part of the 
OpenWorks interpretation data record. Here are some of the many ways Interpretation Notes 
can be used:

— As captured “To-Do” lists for completing the interpretation.

— As “Why” notes that document the interpreter’s reasoning at a key decision point.

— As “Knowledge-Capture” notes that provide quick and easy access to published articles 
or previous interpretations. 

These features combine for a significantly enhanced interpretation experience and provide 
opportunities for increased productivity and improved quality.

• Interpretation Sets. Effective data management is one of the more challenging tasks for 
today’s interpreter. A multitude of different data types as well as different versions of data can 
collectively contribute to a specific decision. This combination of data can vary from the set of 
input horizons, picks, velocity model, and fault polygons that contribute to a particular surface 
grid construction to the appropriate set of horizons, faults, velocity model, and seismic that 
represent the properly versioned 85 percent confidence/risk prospect interpretation. 
Interpretation Sets allow the interpreter to create logical groupings of projects information, 
organized and named in hierarchical folders. These groupings, or mini-projects, can be easily 
and quickly recalled for scenario/version/risk-confidence workflows and operations.

• GeoProbe 2D Line Probes. With support for 2D seismic interpretation in GeoProbe, the tight 
GeoProbe > PowerView integration which syncs up a GeoProbe probe face to a PowerView 
Section is extended to include 2D seismic data.

SeisWorks 

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data, 
major enhancements to the Interpretation ID Model, the addition of metadata and Processing 
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History Model, redesigned Data Managers, and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• Horizons and 2D Lines. There are no more limits on the number you can use.

• Processing History. You will be able to access this information for horizons and seismic. The 
enhancement eliminates the need for elaborate naming conventions. 

• Identification of Horizons. They are identified by name, version, interpreter, and attribute.

• Additional Meta Data. This information is available for horizons, seismic, and faults.

StratWorks

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data; 
major enhancements to the Interpretation ID Model; the addition of metadata and the Pro-
cessing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Surface Mapping Enhancements. StratWorks was enhanced to include dip and azimuth 
calculations with pick data and to grid dip data to use in surface mapping. The purpose of this 
enhancement is to calculate dip information to include with pick data in the PICK table. Dip 
meter table data is averaged to calculate values.

SynTool

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project 
Optimization, which enhances the data model to support new workflows, reduce cycle time, 
and fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the 
OpenWorks Data Model to enable the storage and management of seismic and associated 
data; major enhancements to the Interpretation ID Model; the addition of the metadata and 
Processing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Tighter integration with OpenWorks. This release dramatically improves the way that 
seismic and associated data are managed and stored. SeisWorks projects have been 
eliminated, and OpenWorks is extended to manage seismic and other project data. Seismic 
data and 3D horizon data are stored externally but catalogued and managed through 
OpenWorks. 2D horizon data is stored within OpenWorks.

• Datum Behavior. Modifications in datum behavior make it work in conjunction with the 
automatic datuming of SeisWorks seismic data provided by the OpenWorks seismic data 
optimization in Release 5000.0.0. The changes mean there is both a datum and correctional 
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velocity tied to the Interpretation Project (IP) and a datum tied to the 3D survey and the 2D line 
seismic data. They work together to provide dynamic datuming of the seismic data to the 
datum of the IP. Because the datuming or start time modification of the seismic data is being 
performed on the OpenWorks side and is external to the SynTool application, SynTool now 
includes some minor changes concerning the initial Time datum setting and the updating of 
the datum when SeisWorks seismic data is selected for display.

In previous releases, the initial SynTool Time datum would be set by selecting a SeisWorks 
project. You could then modify the datum value before completing the initialization of the 
SynTool session. For Release 5000.0.0, the initial time datum will be set to the datum of the 
Interpretation Project that you are using. This change is required to maintain integration with 
SeisWorks, which also uses the IP datum when initializing. Because the SeisWorks seismic 
data is tied to this datum, you will not be able to modify the datum during initialization. You can, 
however, modify the datum setting once the session has initialized by using Datum Info. 
Another change revolves around the selection of SeisWorks seismic for display. In the 
previous release of SynTool, if the selected seismic data was from a different SeisWorks 
project at a different datum from the SynTool, the SynTool session would change the current 
datum to this datum and use its internal method for calculating the correctional velocity for 
setting the datum shifted time scale. In Release 5000.0.0, because the SeisWorks seismic 
data is being dynamically datumed to the Interpretation project datum using the correctional 
velocity in the IP, this option is no longer required and has been removed. To maintain 
consistency with SeisWorks, use or modify the settings in the Interpretation Project if the initial 
datum needs to be set to a different value. If the datum of the seismic data needs to be 
changed, do so in the 3D Survey or 2D Line setting in Seismic Data Manager, before you 
launch SynTool. 

Once the SynTool session has initialized, you can make datum modifications by selecting 
Datum Info from within the SynTool application. Likewise, if you are looking for the same 
behavior as in earlier releases, set the IP datum to 0 and the 3D Survey or 2D Line datum 
to 0. Then use Datum Info and SynTool’s internal datuming calculations to provide the datum 
modifications for the SynTool session.

• SynTool Fixed Problems:

— Defect #760430: When saving a synthetic to SEG-Y you can now enter up to 200 charac-
ters for the file name. This has been increased from 54. 

— Defect #631615: Extraction process hangs when you extract Wellbore Seismic for a hori-
zontal well.

— Defect #739567: It is taking too long to access a seismic volume list or SeisWell. Need a 
patch to improve performance. (Fixed with the OpenWorks Seismic data management.)

TDQ

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project 
Optimization, which enhances the data model to support new workflows, reduce cycle time, 
and fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the 
OpenWorks Data Model to enable the storage and management of seismic and associated 
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data; major enhancements to the Interpretation ID Model; the addition of the metadata and the 
Processing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Tighter integration with OpenWorks. This release dramatically improves the way that 
seismic and associated data are managed and stored. SeisWorks projects have been 
eliminated, and OpenWorks is extended to manage seismic and other project data. Seismic 
data and 3D horizon data are stored externally but catalogued and managed through 
OpenWorks. 2D horizon data is stored within OpenWorks.

• Sharing of Models. TDQ models are stored in the master project and not the Interpretation 
Project, so the model can be shared. 

• Simplified and Optimized Project Administration. This change eliminates the need for 
seismic projects in SeisWorks. Master and working projects have been integrated into the new 
OpenWorks structure.

• Identification of Horizons. They are identified by name, version, interpreter, and attribute.

• TDQ Fixed Problems:

— Defect #717279: Setting Sample Interval less than one defaults back to one upon conver-
sion.

— Defect #730538: Does not convert OpenWorks grids properly when depth units differ 
from project units.

— Defect #632665: Does not like sub-millisecond sample intervals.

— Defect #702403: Creates line thickness value of -98765 in SFDM. 

Well Seismic Fusion

• Prestack Seismic Data Management via OpenWorks. To make prestack seismic data 
accessible to any interpreter at any time, Well Seismic Fusion now catalogs the prestack data 
in OpenWorks. The catalog contains basic survey geometry, parent/child relationships, and a 
pointer to where the prestack actually exists on disk.

• Offset Synthetics and VSP Data Managed via OpenWorks. Well Seismic Fusion now 
stores 2D offset-synthetics and offset-VSP data directly in OpenWorks. This change allows 
any interpreter to access these data types at any time. 

• Working with Multiple 2D Lines; 3D Surveys; and Interpretation Projects. Well Seismic 
Fusion can now manage any number of 2D lines or 3D surveys within any number of 
interpretation projects in a single session.

• “Basic” and “Full” Licensing of Well Seismic Fusion. A less-expensive “Basic” License is 
now available for users who just want to view and crossplot prestack data. The “Full License” 
allows for much more in-depth AVO analysis on all data types. 
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Z-MAP Plus

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data; 
major enhancements to the Interpretation ID Model; the addition of metadata and Processing 
History Model; redesigned Data Managers; and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• File Manager Enhancements. The time of file creation is now displayed as well as the date. 
This allows for sorting of files by date and time. In addition, the number of ZGFs that can be 
listed has been increased from 1000 to 12000. The number of MFD and OpenWorks files 
(such as grids, pointsets, etc.) has increased from 1000 to 9999.

• Text Posting Enhancement. You can now specify that you want to clip text files posted on 
maps at the map border.

• Contour Enhancements. Z-MAP Plus has enhanced the Contouring GUI to include distance 
between labels; and bold, hachure, and dash contour settings. (60657)
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Information Management and Infrastructure

OpenWorks information is located on page 49.

Advanced Data Transfer (ADT)

• Data Tree Editor. This feature makes it significantly easier to build custom connections to 
third party data models.

• Position Logs. These are automatically computed when loading directional surveys to 
OpenWorks.

AssetJournal

• Support for All Release 5000.0.0 Platforms. AssetJournal is supported on the following 
Release 5000.0.0 platform standards: Windows XP & 2003 Server - 32 & 64 bit; RedHat ES 
Linux 5.0 – 64 bit; and Solaris 10 – 64 bit

• Improved Performance. The entire application and all associated components have been 
rebuilt and are bundled with the latest version of Java. These enhancements, coupled with 
some internal changes, make overall performance faster.

• Project Storage Optimized. Support for jpg output has been added as a project parameter. 
This enhancement can drastically reduce the disk usage per project. The original images are 
retained, however, so it is possible to switch back without any loss of image quality.

• OpenJournal Functionality. There is an ongoing effort to reproduce functionality from 
OpenJournal in AssetJournal. These enhancements include the introduction of project 
options, installation settings, TOC and HOME page settings, workflow changes, and more.

AssetView

• Support for Release 5000.0.0 OpenWorks Data Model. AssetView now supports the new 
OpenWorks and SeisWorks data model changes, which enable easier access to horizon data, 
2D and 3D seismic data, and metadata. 

• Wellbore Analyzer Integrated with AssetView. Wellbore Analyzer is an AssetView tool that 
extracts the intersections of geobodies with wellbores and well plans. It displays these 
intersections as lathes for seismic volumes, 3D grids, and as intercepts for horizons and 
surface grids in the 3D view and/or in a table view. For Release 5000.0.0, this tool is integrated 
with AssetView and does not require a separate license. As a result, you are provided with 
greater functionality in AssetView itself.

• DecisionSpace Desktop. AssetView 5000.0.0 launches in DecisionSpace Desktop. 
DecisionSpace Desktop provides a configurable launcher that can launch Landmark’s 
DecisionSpace and Classic applications, plus external applications, even if they do not appear 
in the common tab-view-enabled frame. As a result, it provides a seamless viewing 
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experience. DecisionSpace applications that choose to launch in the Desktop display their 
initial interface as a tabbed view in the DecisionSpace Desktop. 

DecisionSpace Infrastructure

• DecisionSpace Desktop. DecisionSpace Desktop is a new component in Release 5000.0.0 
and is installed with all Release 5000.0.0 DecisionSpace applications that choose to launch in 
the Desktop. DecisionSpace Desktop provides a configurable launcher that can launch 
Landmark’s DecisionSpace and Classic applications, and external applications, even if they 
do not appear in the common tab-view-enabled frame. As a result, it provides you with a 
seamless viewing experience. DecisionSpace applications that choose to launch in the 
Desktop display their initial interface as a tabbed view in the DecisionSpace Desktop. 

• Additional Platforms Supported. DecisionSpace 5000.0.0 is now supported on Windows 64 
bit and Red Hat ES Linux 5.0 64 bit. This version of DecisionSpace is also compatible with the 
new security changes in Windows Vista.

Engineer’s Data Model (EDM)

• Improved Coordinate Transformations. This enhancement is available through support for 
Blue Marble 6.2.

• EDM to OpenWorks Link Utility. It uses the OpenWorks 5000.0.0 Development Kit to map 
data in the OpenWorks data model. The installed OpenWorks client is a prerequisite. 

• Fixed Problems. The following significant defects were corrected:

— Defect #745480: EDM properties of type java.util. Calendar should not have their 
ValueInfo implement UnitInfo since date properties should not have units, Date ValueInfo 
no longer implements UnitInfo.

— Defect #749048: EDM ObjectConnect Login Screen should be more like what we see in 
EDM, dropdown of the databases available for user to choose. When setting an EDM 
ObjectConnect connection, users can now select available servers and databases from a 
dropdown list instead of typing the server and database.

— Defect #745438: String properties should not have a unit. There are now no 
type-specific ValueInfo implementations for fields of type BLOB, CLOB and DATE type 
fields other than the default ValueInfoImpl.

OpenVision

• Support for Release 5000.0.0 Platforms. Besides supporting the new platforms, OpenVision 
includes corrections for several defects. 
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PowerExplorer

• ASCII Macro Files. The ASCII (xml) alternative offered in Release 5000.0.0 eliminates the 
following problems with PowerExplorer’s session save/restore mechanism: Sessions cannot 
be shared across dictionaries, they cannot be edited, and they are not accumulative. The 
ASCII (xml) alternative also provides a basis for future workflow automations (macros).

• Better GUI for Case-Sensitive Queries. The cryptic operator names used in PE2003.20.0 
have been replaced with a simple toggle in the task details area.

• GISView Coordinate System Handling. You now have better control over the coordinate 
systems. You will also see improved datum transformations when reading local shapefiles.

• Usability. These improvements include multi-column selection in the TaskBuilder GUI; a 
filtering mechanism in the data source selection dialog box; more and better pick lists and 
drilldowns in various OpenWorks tasks; and a progress indicator for TableView create/update/
delete (CUD).

• WellLogView Marker Support. Various mechanisms now make it possible for you to overlay 
log curves with marker information, such as picks.

• New Metadata Functions. PowerExplorer/PowerHub provides a mechanism that allows topic 
attributes to be computed. There are new functions for unit and coordinate system 
conversions, as well as full access to wellbore path calculations (interpolation of tvd, tvdss, dx, 
dy, etc based on md). These calculations can be configured to use either OW or CDS poslog 
data. Creating pure computational tasks is easy when you use the mechanism with the new 
EchoAccessor. It can also be used in TaskBuilder tasks.

• Cross Database Comparisons. PowerExplorer’s drilldown mechanism normally expects the 
drilldowns to be within the same database. In Release 5000.0.0, there is a self-drilldown for all 
tasks, as well as a new drilldown option that provides more flexibility in the attribute mappings.

PowerHub Server

• AutoConnect Wizard. It provides full Create, Read, Update, and Delete functionality, 
enhancing the Read capabilities of Release 2003.20.

• Queries. You can now perform queries using Area of Interest (AOI) as a constraint.

• Fixed Problems. The following defects have been corrected:

— Defect #750194: Get WGS84 versions of coordinates from any location data served by 
PowerHub. User can now specify an output CRS for coordinates.

— Defect #742064: View Relations in PowerExplorer are now configurable using relation 
and capability properties.

— Defect #744846: Turkish character support in PowerExplorer for MDS Connect. A new 
JDBC driver wraps around (references) the real driver, translating problematic Unicode 
where necessary.
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Team Workspace

• User Interface Evolution. Web application technology has been evolving at a fast pace. New 
techniques and tools enable the creation of richer end-user experiences. The Team 
Workspace end-user interface is undergoing an evolution to make use of some of these newer 
technologies. Changes will result in streamlined interfaces with applications, more intuitive 
functionality, and the ability to developer much richer applications. The platform for this 
migration is ASP.Net.

• PetroBank Explorer. This new feature is a customization of Team Workspace. It provides fast 
and simple access to data and data-driven workflows based on the PetroBank Master Data 
Store. One key aspect of this feature is its integration with a search engine. This functionality 
will provide a path for the future integration of index searching within Team Workspace. This 
will not be available until MDS 5000.0.0 is released in mid-2008. 

• Data Store Plug-In Framework. To help Team Workspace sites start up quickly, this module 
plug-in has been developed. It allows you to create workspaces by using XML templates. 
These templates will create projects, connections, catalogues, applications, and more. Plug-
in XML templates can be shared.

• MDS Ordering Extension. The interface with PetroBank Master Data Store currently 
supports the ordering of three data types: Well log curves, Seismic Projects, and Archive 
Objects. In Release 5000.0.0, two new types will be added: Individual Seismic Sections and 
Seismic Navigation Data.

• Project Copy. Many companies organize their Team Workspace deployments around 
projects. When a new project starts, they build a consistent Team Workspace Project to 
maintain this activity. To facilitate this function, a Project Copy feature is being added. This 
feature will enable duplication of an existing project. A project can be created as a clean 
Master Project, which can be used as the source project for the copy.

WOW/CDA/PA

• Platform Support. WOW/CDA/PA supports the new platforms in Release 5000.0.0.
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Reservoir Management

DMS

• Field Plan Workflow. DMS now incorporates a FieldPlan workflow. To run this workflow, you 
use FieldPlan to create a spreadsheet. You then build a DMS Fieldplan spreadsheet model 
and run multiple iterations of FieldPlan from within DMS.

• Expanded Set of Inputs. When running with Nexus, DMS now has access to an expanded 
set of inputs that are provided by running Nexus in the “structured grid” mode.

• New Gaslift Outputs. These have been added to the VIP job builder.

• New Job Monitor. This feature provides graphical updates on the progress of a job.

• Simplified Configuration Issues for Setting Up Grids. When running simulation-
spreadsheet workflows on a grid, the spreadsheet calculations are now performed on the job 
agent, while the simulation jobs are executed on the various nodes of the grid. This 
implementation simplifies the configuration issues for setting up the grid. The spreadsheet 
calculations are performed on the job agent for all three types of jobs: uncertainty only, 
optimization with no uncertainty, and optimization with uncertainty.

• Redesigned Job Builder. The following changes were made:

— Building a job is now much easier. Many of the job inputs and outputs that previously had 
to be entered manually can now be selected from menus or pulldown lists.

— Inputs and outputs can now be selected from pulldown lists.

— Output combinations can be saved and restored as “configurations.”

— Behaviors for building different types of jobs are more consistent.

— Combined spreadsheet-simulation models can be created automatically by the job 
builder.

• Expanded Post-Processing Functionality. Post-processing is now licensed separately from 
the history-matching utility and can be used for general purpose data analysis. Post-
processing provides analytical and visualization tools for examining data that is stored in a 
DMS database. Supported plots include the following:

— histograms

— time series plots

— crossplots

— tornado plots

— correlation matrix plots
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Particular sets of plots can be saved with a post-processing configuration tool so that they can 
be quickly restored during later sessions. History matching inputs can be imported from history 
matching jobs and viewed with the history matching results.

• Fixed Problems. The following significant defects were corrected:

— Defect #751478: GAP jobs require MBAL in order to run, even if the GAP model does not 
use MBAL data. If the user does not have an MBAL installation and a valid MBAL license, 
the GAP job will fail.

Some GAP results cannot be retrieved from OpenServer, even though the results appear 
in the GAP results table and the OpenServer string can be extracted from the table. This 
problem occurs with results that appear in the Results table after running prediction. The 
workaround is to use only OpenServer strings that are listed in the Results tables before 
running prediction.

— Defect #752162: In the PDF Finder tool invoked from the PDF and Correlation Finder util-
ity, the beta distribution uses different inputs than are used to define by the model build-
ers. These input parameters should be the same for both the model builder and the PDF 
Finder. 

— Defect #752990: The post-processing utility requires input data to be loaded in order to 
display output data. Currently, the user must select some input data when loading the 
results from a job to the post-processing utility. If a job does not include uncertainty or 
decision parameter inputs, it cannot be loaded for viewing. 

— Defect #751711: When building a job, the user can map different data entities to the 
same variable in a script. This should not be possible. For example, the user should not 
be able to assign two different outputs from a simulation job to a single variable named 
“a1.” The workaround is for the user to assign only one data entity per variable in the 
script.

— Defect #744893: The new job builder provides a new Interim tab that lists application out-
puts that are used as inputs to calculators or to a spreadsheet. These outputs are listed in 
the Interim tab so that users can specify whether they want to output them to the DMS 
data store. However, the ability to select them for output has not yet been implemented.

The early access PDF and Correlation Finder utility is not documented in the DMS main 
workflow help. However, documentation for the different plot types is available from the 
Help buttons on each of the plot dialog boxes.

— Defect #746193: The job builder allows the user to select any correlation model when cre-
ating a job. However, if the user selects a correlation model not associated with the model 
used in the job, the job fails to run. The user should be restricted to selecting correlation 
models associated with the models in the job. 

— Defect #730912: Post-processing Utility for History matching: Time series and vector data 
for same property have the same column headings. 

— Defect #731222: Results browser: When launching the data browser, you can select a job 
that does not have data in the database because the data has been deleted or because 
the original database has been replaced. Making this selection will cause a  
DecisionSpace Recovery Dialog Box message to display. 
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DMS has been tested on Windows XP in English only. Applying different language settings 
to the Windows XP has not been tested.

— Defect #617355: The security setting on MS Access may prevent DMS from using Access 
database. The workaround is to set the Access security level to low. 

Windows XP Service Pack 2 may cause problems displaying the help system. SP2 
automatically sets the Internet Explorer security to a higher level than previous service 
packs did. As a result, you may have to approve the display of each page of the help 
system. 

FieldPlan

• Cost Database. It has been updated to reflect the market trend to January 2007.

• Integration. FieldPlan is integrated with DMS to enable users to take advantage of other 
powerful Landmark application packages.

• Offshore Cost Database Program Updates. You can now display database properties and 
see modified data values in red colors. A new functionality is also implemented in the Offshore 
Cost Database program for users to add/delete benchmark projects in user-customized cost 
databases.

• FieldPlan Benchmark Projects. These are updated to include more projects. The 
benchmark data are also expanded with total project cost escalation factors and year of first 
production to account for inflation.

• Selection of Benchmark Projects. A new dialog box lets users select the benchmark 
projects to be included in the benchmark chart.

• New Menu. A Tools/Options... menu in the FieldPlan Offshore program lets users set the 
FieldPlan output directory, the directory path for standard cost database files from FieldPlan 
releases, and a few other options.

• Help. FieldPlan Online Help and user documentation have been updated for the new 
functionality.

Nexus

• Satellite production may be modeled by including phase source terms at any point along 
the surface network. This allows inclusion in the network calculations of estimated rate 
information from areas which are currently not being modeled as part of a given simulation. 
Any phase (OIL, WATER, or GAS) may be added for black-oil models and WATER and 
specified STREAM compositions may be added for EOS models. 

• Energy Balance. Temperatures in the surface network can be calculated using a simplified 
heat transfer option. The option uses heat transfer coefficients (HTC) for connections and 
wells, and specific heat capacities for each fluid phase to perform an approximate heat loss 
calculation. A default heat transfer coefficient can be defined, or a heat transfer coefficient can 
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be defined for each connection from the SimDataStudio Surface Network Connections panel. 
A temperature profile (TEMPPR) must also be specified.

• Gas Handling. Gas burnt as fuel or lost to shrinkage can be modeled using the QFUEL, 
FFUEL, QSHRINK, and FSHRINK constraints in Nexus. These constraints specify the amount 
of gas that will be removed at any given connection.

• Gas Lift Valves. The location where gas lift gas is injected into a production network is 
specified by assigning one or more connections as having TYPE GASLIFT in a NODECON 
table. Gas lift connections can be located anywhere in the production network and must have 
a maximum gas rate (QGSMAX) constraint specified. Downstream of a gas lift connection, the 
fluid flowing in the network will include the fluids produced from the reservoir and the gas lift 
gas injected. Gas lift connections will shut in automatically if there are no other fluids flowing 
at the gas lift injection node.

• Gas Lift Optimization. A gas lift connection can be optionally assigned an OPTGLR table. 
The OPTGLR table specifies the optimal gas/liquid ratio or gas/oil ratio for a well (or 
connection) as a function of water cut, liquid, or oil rate and mobility-weighted pressure for the 
flowing perforations. The optimal GLR or GOR includes both gas lift gas and produced gas, 
so the gas lift injection rate is obtained by interpolating the optimal GLR (or GOR) from the 
table, multiplying by the liquid (or oil rate) production rate, and subtracting the gas production 
rate. If this calculation results in a negative gas lift injection rate, the gas lift connection is shut 
in. A new optimization algorithm has also been implemented which allows optimization to be 
performed based on user input stream values. 

• Gas Plant. Another method of defining surface separators for well streams is designed to 
simulate the presence of a gas plant at the surface. This method can be used whenever the 
standard option of using a set of surface flashes at a fixed temperature and pressure is not 
satisfactory. This method uses liquid molar recovery fractions for each component. The 
fractions are input as a function of the key-component-plus composition in the well stream. The 
key-component-plus composition is defined as the sum of the over-all mole fractions for the 
key-component-plus components, which are explicitly defined by the user. The interpolated 
values of the liquid recovery fractions multiplied by the overall feed composition for each 
component are used to obtain the produced liquid composition. EOS parameters are then 
used to compute liquid densities. Liquid density plus surface total molar production rate for the 
liquid provides the standard surface rate. Gas composition and the densities are determined 
as the product of the quantity (1-liquid recovery fractions) and the overall feed composition. 
Again, the total molar production rate of gas and the density provide the standard surface 
production rate.

• Dual Porosity. Nexus models the dual porosity processes by using two continua representing 
the rock matrix and fractures. These continua are superposed, and the model assumes the 
two continually exchange fluids. Two finite-difference grid systems represent both continua. 
Consequently, you must supply the fracture properties as well as data for the rock matrix. The 
dual option simulates the performance of reservoirs which are naturally fractured, 
heterogeneous, or highly stratified.

• Water Alternating Gas (WAG). Any well can be declared a WAG well, capable of injecting 
either water or gas. The WAG well must be connected to both a water source and a gas 
source. The WAG procedures can be used to automatically cycle a WAG well (or wells) 
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between water and gas injection. The size of the water and gas slugs are input in a WAG table 
(WAG keyword).

• Salinity Tracking. The salinity level of water may be tracked, allowing for variation of water 
properties as a function of salinity.

• Compound Residual Oil. A residual oil saturation option lets you specify the portion of the 
residual oil that cannot be recovered in compositional processes. Without this 
option, it is possible for all the oil in a grid block to be recovered through vaporization and/or 
displacement. 

• Job Submitter. A new job submittal utility provides an improved user interface and better 
feedback for determining the status of jobs submitted. The utility supports parallel jobs run 
locally on Windows or Linux workstations. It also supports parallel remote jobs submitted from 
a Windows workstation to a Linux cluster. 

• Upscaler Workflow. An Upscaler Workflow wizard guides you through a basic workflow for 
upscaling grids. The wizard reduces the upscaling workflow to four simple steps.

• Fixed Problems. The following significant defects were corrected:

— Defect # 740596: On Linux, SimDataStudio may hang when opening and parsing a large 
r.dat file that contains many wells. This issue may be related to the Wine Windows emula-
tor. The problem does not occur on Windows.

— Defect # 735204: The Nexus smart wells workflow may fail if the DecisionSpace meter 
unit is used. 

— Defect #753409: Nexus applications that run Nutcracker shell processes fail when 
“Microsoft Application Compatibility Toolkit 5.0 Data Collector" (ACT-DC) has been 
installed on the local machine. The Nexus applications affected are Job Submitter, 
3DVIEW, PlotView, Gridgenr, and Array. To run these applications, please delete the 
ACT-DC installation with the Add or Remove Program utility in the Control Panel before 
launching Nexus. 

— Defect # 747750: When you import black oil PVT from an existing Nexus file (.fcs) for 
inclusion in a new SDS case, SimDataStudio does not recognize that the data is in a dif-
ferent oil table format. This problem occurs because Nexus and VIP use different formats 
for black oil PVT. The workaround is to change the PVT model format in SDS to 
"enhanced black oil table" (Utility Data > Basic Options > Fluid Model > Enhanced 
Black Oil). Once you have done this, you will be able to import the PVT data.

— Defect # 734018: When working with an existing network in Network Planner, adding a 
valve out of sequence causes existing valves and pipelines to disappear and causes the 
NetworkPlanner tree to lose its proper structure. 
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Appendix A: Hummingbird Exceed Configuration 
Instructions

Many Landmark products used Hummingbird Exceed. Release 
5000.0.0 uses Hummingbird Exceed 2007. Exceed is a third party 
purchase and should be installed using the standard installation 
instructions. This section will define how to configure Exceed for 
Landmark products. 

Exceed 2007 works with 32- or 64-bit applications. Exceed 3D can be 
used with high-end OpenGL applications.

The Hummingbird Exceed X Server must be tuned manually after it is 
installed in order for all Landmark applications to function properly. After 
installing Exceed, perform the following steps to tune the Server:

1. Log in as Administrator.

2. Select Start > All Programs > Hummingbird Connectivity 
2007  > Exceed Tools  > Xconfig. 

The Xconfig control panel opens.

3. In the Xconfig window, click Screen Definition in Classic View, or 
click Display And Video in Category view.

4. On the Screen 0 tab, do the following:

• Select Use All Monitors.

• In Window Mode, select Multiple.

• In the Panning group box, check Panning, select Fast in the 
Speed dropdown list, and enter 25 in the Amount text box.

• Deselect Auto Load XRDB.

• In the Server Visual, select True Color. However, if the color 
depth of the computer is less than 24 or 32 bit, select 
PsuedoColor.

• In Root Size, enter 0 in Width and Height.

• In the Window Manager group box, select Default To Native in 
the dropdown list box, deselect Fit Window To Display, and 
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check Cascade Windows.

5. Select the Common Settings tab.

6. Deselect the Close Warning On Exit box.

7. In the Xconfig window, click Validate And Apply Changes.

8. In the Xconfig window, click Keyboard Input in Classic View, or 
click Mouse, Keyboard, And Other Input Devices in Category 
view.

9. In the Keyboard Input tab, select To X in the Alt Key dropdown list 
box.

10. In the Xconfig window, click Validate And Apply Changes.

11. In the Xconfig window, click Performance in Classic view, or click 
Other Server Settings in Category view.

12. In the Performance tab, do the following:

• In the Drawing group box, deselect Draft Mode; check the 
Exact Zero-Width Lines and Batch Requests boxes. 

• In the Backing Store group box, select When Mapped in both 
the Maximum and Default items. Select None in Minimum.

• In the Advanced group box, check Save Bits and Oversized 
Cursors, and deselect the other checkboxes.

• In the Performance tab, click Tune to start Xperf.

• If the Exceed server is running, Xperf displays an Xperf question 
dialog asking to restart the server and an Xperf dialog.

13. If the Xperf question dialog displays, click Yes.

14. Click Run All in the Xperf dialog. Xperf runs the tests.

A series of graphics will appear in the upper left corner of the 
monitor, and the Xperf dialog box will become inactive.

Other settings

Some dual-monitor video cards may require other settings on the Screen 
tab. Specifying settings for those cards are beyond the scope of this 
document.
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15. When the tests are complete, click OK in the Xperf dialog.

16. In the Xconfig window, click Validate And Apply Changes.

17. In the Xconfig window, click Protocol in Classic view, or click X 
Server Protocol in Category view.

18. In the Extensions tab, and its Enable Extensions list box, check 
GLX (for OpenVision), and deselect XInputExtension.

19. Select GLX to highlight it in the Enabled Extensions list box, not to 
check or deselect its checkbox.

20. Click the Configure button to display the Configure GLX dialog.

21. Check the Hardware Acceleration and One Visual Per Pixel 
Format boxes, but deselect the other checkboxes.

22. Direct Rendering and Overlay Support should not be checked. 
Potentially bad behavior could result if they are enabled.

23. Click OK in the Configure GLX dialog box.

24. In the Xconfig window, click Validate And Apply Changes.

25. Select File > Exit to close the Xconfig control panel.

26. This completes the Hummingbird Exceed X Server configuration 
process. It is not necessary to reboot the computer.
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Fonts in Hummingbird Exceed
Hummingbird Exceed can have difficulties dealing with many fonts. If 
some Landmark applications have problems displaying labels or other 
text, Exceed may have too many fonts or font servers.

To delete unnecessary fonts or servers, do the following:

1. Log in as Administrator.

2. Select Start > All Programs > Hummingbird Connectivity 2007 
 > Exceed Tools > Xconfig. 

The Xconfig control panel opens.

3. Click Font in the Classic view, or click Font Management in 
Category view.

4. In the Font tab, click Edit. 

The Font Database dialog box displays.

5. For each unnecessary font:

• Select a font description in the list box.

• Click Delete.

6. When finished deleting fonts, click OK to close the dialog.

7. Click Validate And Apply Changes in the Xconfig window.

8. Close the Xconfig window.

9. Restart the Exceed X server.
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Appendix B: Helpful Internet Links

Name Website Address

Landmark Graphics home page http://www.halliburton.com/landmark

Oracle home page http://www.oracle.com

FLEXlm license management 
software 

http://www.macrovision.com

SQL Server Express 2005 home page http://www.microsoft.com/sql/editions/ 
express/default.mspx

Adobe Acrobat Reader http://www.adobe.com

Microsoft MSDE http://www.microsoft.com/sql/
default.asp

http://www.lgc.com
http://www.oracle.com
http://www.macrovision.com/support/by_category/Software_Licensing.shtml
http://www.microsoft.com/sql/default.asp
http://www.adobe.com
http://www.microsoft.com/sql/default.asp
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